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Note

inpO2 imposition software has been developed for imposition profes-
sionals. It is very flexible and easy to use. However, we recommend
that the user be familiar with Adobe Acrobat and Macintosh or Win-
dows Operating System before using this software.

inpO2’s user interface is almost identical on Macintosh and Windows
platforms. However, some functions may differ slightly from one
environment to another. The Command key on the Macintosh system
is equivalent to the Ctrl key on the Windows system. All contextual
menus available on Windows using the right-click are available on
the Macintosh system with CONTROL-click.

This User Manual can be accessed through the inpO2 Help menu and
on our web site at www.dynagram.com. Please note that all updates
are posted on our web site.
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Technical Support 

If you are a registered customer and require assistance concerning
inpO2, please fill out the Support Form on our web site, at
www.dynagram.com/support. It is the fastest and most efficient way
to diagnose and resolve your issue.

For immediate assistance, you may contact:

United States & Canada

Tel.: 418-266-1275
Fax: 418-694-2048
E-mail: support@dynagram.com
www.dynagram.com/support/

Other Countries

Contact your distributor or reseller.

For additional information concerning customer support and the
Annual Support Agreement, see the Support section on our web site
www.dynagram.com.
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1 Introduction
inpO2 is an Adobe® Acrobat® Plug-in designed to operate within
Acrobat Standard or Acrobat Professional (recommended) on both
Macintosh or Windows platforms. 

inpO2 creates sophisticated impositions and imposition layouts
using PDF format. Sheets or Plates are PDF pages and all printable
layout elements are PDF objects. 

1.1 WYSIWYG Imposition

1.1.1 Acrobat Workspace

inpO2 uses the Acrobat workspace as a light table for imposition.
Sheets or Plates are PDF pages and all printable layout elements are
PDF objects. The user interface completely integrates into the Acro-
bat environment. Menu items and toolbars are added to Acrobat as it
launches. 
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In addition to its own inpO2 menu, tools and functions, inpO2’s nav-
igation uses various Acrobat interface elements such as:
• File, Edit and Help menus
• Pages panel for navigation using thumbnails
• Page layouts (single, continuous, facing or continuous facing)
• Zoom tools
• Undo and Redo controls, etc.

Working in Acrobat Professional allows to benefit from other func-
tions such as:
• Overprint Preview and Output Preview palette to change the 

display of ink colors 
• PDF Optimizer 
• Print Production tools 
• Print options (color separation, tiling, etc.) for PDF impositions
• Measuring tools, annotations, etc.

For more information on Acrobat features and tools, consult Acro-
bat’s documentation, from the Help menu.

1.1.2 Profiles

inpO2 profiles are made of a set of options used to adjust the visibil-
ity of any object on the light table as well as upon output. inpO2
offers three basic profiles for working, proofing and output. In addi-
tion to these basic profiles, custom profiles can be saved. Any type
of object combination for screen preview, proofing or imaging can be
created. 

For more information about using profiles, see section 2.4: Profiles.

1.1.3 inpO2 Working Modes

inpO2 offers different approaches to create imposition layouts. 
• The Wizard, that may be used for quick and easy project 

creation, for bound works or flatworks.
• The Light Table, that is suited for template creation and fine 

control on all objects. It also allows for producing complete 
impositions on the fly for flatworks or publications that require 
simple pagination.

• The Layout Manager, using equipment specifications and 
available materials for the planning of bound publications and for 
the optimization of sheet usage.

• The template-based Assembly Manager, with its powerful 
pagination algorithms, including options for web presses.

• The Automation Manager, making full use of the Wizard and 
Output Configuration presets to generate imposition jobs without 
user intervention.
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The following illustration is a simplified activity diagram for inpO2
main workflows.

1.1.4 File Types

inpO2 saves work files in four different formats:
• Layout files (*.layt) contain all sheets and objects on the light 

table, and may contain document run lists (see section 2: “Light 
Table Tools”). It is the default format. Layout files can be created 
for simple jobs or exported as templates to be used in the 
Assembly Manager. 

• Template files (*.tmpl) are meant to be used in the Assembly 
Manager. They contain all the sheets and objects on the light 
table, without source documents (see section 4.2.2: “Templates”). 
Templates are protected. When a template is opened on the light 
table, it turns into a layout. 

• Assembly files (*.ably) contain the entire assemblies, including 
binding information, sheet templates and source documents (see 
section 4: “Template Assembly”). Assembly files can be exported 
as layout files to be manually edited on the light table.

• Managed Layout files (*.mlay) contain all production information 
that is required for the Layout Manager, whether for sheet 
optimization or bound projects (see section 5: “The Layout 
Manager”). Managed Layout files can be exported as layout files 
to be manually edited on the light table.

In addition to saving in these file types, inpO2 can also export lay-
out content in ATM format (*.tpl) from the Acrobat file menu (see
section 2.5.4: “Exchanging Presets”).

1.2 User Interface Overview

The main components of inpO2’s interface are:
- Menus and Toolbars
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- Light table
- Presets and Object Properties palette
- Wizard
- Automation Manager
- Layout Manager
- Assembly Manager
- Document Manager
- Ink Manager
- Output

1.2.1 Menus

File Menu Acrobat’s File menu contains commands to Open, Create, Export
inpO2 layouts, templates, assemblies and managed layouts. You can
also export your layout as a template for ATM (*.tpl) in the file
menu (see section 2.5.4: “Exchanging Presets”). Finally, the Auto-
mate inpO2 menu item will open the Automation Manager window.

Edit Menu Acrobat’s Edit menu contains commands to Undo and Redo. The Pref-
erences menu gives access to Acrobat’s preferences and inpO2 prefer-
ences as well (see section 1.3: “Preferences”). 

inpO2 Menu inpO2’s menu is located in Acrobat’s main menu bar. This is where
you can access your workspace parameters and all modules to create
your imposition.
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Contextual Menu Right-clicking (Ctrl-click on Macintosh) on any object on the light
table provides access to a contextual menu with various options per-
taining to the selected object. To select an object within a page
group, use Shift + right click.

For example, you can apply a folding to a selected page group, or a
source document to a selected page.

1.2.2 Toolbars

inpO2 toolbars appear among the Acrobat toolbars (these toolbars
can be displayed/hidden via the View > Toolbars menu or by right-
clicking in the toolbars area). They provide quick access to most
tools, dialogues and modules. They can be converted into floating
palettes and positioned anywhere on the screen for easy access.

To customize the toolbars, choose Tools > Customize Toolbars.... and
select or unselect the tools that you want to view or hide.

You can also customize the display of the button labels through View
> Toolbars > Button Labels.

Tooltips display the description for each icon when the mouse cursor
is positioned over it for about one second.

inpO2 offers three toolbars: inpO2 Tools, inpO2 Objects and inpO2
Functions.

In Acrobat X and XI, all inpO2 toolbars can be found in the Tools
right panel.
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inpO2 Tools The inpO2 Tools toolbar contains buttons to select an object, to pagi-
nate, position and access the profiles preset.

inpO2 Objects The inpO2 Objects toolbar contains buttons to both set the properties
and add objects: page groups, imported marks, text marks, collating
marks, register marks, density bars and linear marks. Clicking on the
arrow next to the icon opens the mark’s sub-menu.

inpO2 Functions The inpO2 Functions toolbar gives access to the main functions such
as Layout Manager, Assembly Manager, Document Manager, Ink Man-
ager, Checkpoints, Mark Sets and PDF/JDF Output.

(see section 2.4: “Profiles”)

(see section 2.2.1: “Manual Pagination”)

(see section 2.1: “Object Selection Tool”)

(see section 2.3: “Object Properties Palette”)

(see section 1.5.3: “Inserting a Blank Sheet”)

(see section 3.8: “Mark Sets”)

(see section 3.7: “Linear Mark”)

(see section 3.6: “Density Bar”)

(see section 3.5: “Register Mark”)

(see section 3.4: “Collating Mark”)

(see section 3.3: “Barcode”)

(see section 3.2: “Text Mark”)

(see section 3.1: “Imported Mark”)

(see section 1.6: “Page Groups”)
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1.2.3 Light Table

The light table view is the default interface in inpO2. It is used to
create imposition layouts with ease and precision. 

inpO2 transforms Adobe Acrobat Professional into a traditional light
table where press sheets are large PDF pages and where PDF objects
are placed and mixed with source documents to create the final
imposition. 

inpO2’s light table features intuitive functions for creating layouts,
including:
• Presets for all imposition objects (see section 2.5: “Presets”)

(see section 9.1: “Main Output Dialogue”)

(see section 5.2.3: “Checkpoints”)

(see section 8.1.7: “Shortcut to documents from the light 

(see section 8.1: “The Document Manager”)

(see section 4.2: “The Assembly Manager dialogue”)

(see section 5.2: “The Layout Manager dialogue”)
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• Object Properties palette (for position, scaling, offset and 
rotation) (see section 2.3: “Object Properties Palette”)

• Checkpoints that validate the layout and warn the user of 
potential problems (see section 5.2.3: “Checkpoints”).

• Floating toolbars (see section 1.2.2: “Toolbars”)
• Contextual menus: see sub-section  "Contextual Menu" in section  

1.2.1: “Menus”
• Group selection and positioning (see section 2.1.1: “Adding an 

Object on the Light Table”)
• Drag & drop (see section 2.1.2: “Positioning an Object on the Light 

Table”)
• Rulers and snap guides (see section 2.1.2: “Positioning an Object 

on the Light Table”)
• Multiple undos and redos from Acrobat’s Undo/Redo commands.

1.2.4 Assembly Manager

The Assembly Manager is the module where imposition templates are
assembled into booklets and automatically paginated. It offers an
innovative, intuitive, robust and flexible interface for publication
assembly. inpO2’s unique Assembly Tree view supports the most com-
plex paginations instantly, in a few clicks of the mouse. 

However, the Assembly Manager is not required for commercial flat-
work or simple jobs when there is no need for automatic pagination
or creep compensation. These jobs can be entirely executed on the
light table.
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This module features:
• Template preview and properties - (see section 4.2.2: 

“Templates”).
• Drag & drop of elements to define the assembly - (see section 

4.3.3: “Drag & Drop”).
• Easy gathering and ordering of booklets in the tree which visually 

simulates the binding - (see section 4.3: “Working with the 
Assembly Tree”).

• Powerful creep algorithm - (see section 4.5: “Creep 
Compensation”).

• Dynamic property panel for each type of node: assembly, booklet, 
page range and page - (see section 4.2.4: “Node Properties”).

• An Insert dialogue to create multiple booklets from one template 
- (see section 4.3.5: “Insert Wizard”)
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• Support for multiple assemblies - (see section 4.2: “The Assembly 
Manager dialogue”).

1.2.5 Layout Manager

The Layout Manager offers a planning approach to imposition, an
efficient way to create imposition layouts that fit with the produc-
tion capabilities since it is based on product specifications, available
equipment and available materials. 

The Layout Manager features include:
• Equipment and material presets (see section 5.1: “Presetting 

Materials and Equipment”),
• An Optimization module for ganging (see section 5.3.1: “Ganging 

Optimization”),
• A convenient step and repeat tool (see section 5.3.2: “Step and 

Repeat Tool”),
• A Planning module to for bound jobs (see section 5.3.3: “Planning 

a Bound Job”),
• Checkpoints that validate the layout and warn the user of 

potential problems (see section 5.2.3: “Checkpoints”).

1.2.6 Wizard

The Wizard offers an easy way to generate complete layouts in just a
few steps, making the imposition process as simple as it gets. A
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source file is first selected, then sheets and page groups are defined.
Add the appropriate marks, and the layout is ready for output.
Everything needed to produce a simple project is gathered under one
dialogue (see section 6.1: “Creating a layout with the Wizard”).

1.2.7 Document Manager

The Document Manager is the module where you manage source doc-
uments and all types of page adjustments. 

It features:
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• Multiple run lists for complex projects (see section 8.1: “The 
Document Manager”),

• Automatic indexing of PDF documents and ink detection, 
• Run List and document page range edition see section "Importing 

Documents Into the List" ,
• Insertion of Blank or Reservation pages see section "Inserting a 

Blank Page" ,
• Drag and drop of documents in the list,
• Adjustments for odd and even pages, or individual pages with 

page preview (see section 8.1.6: “Page Adjustments”).

1.2.8 Ink Manager

The Ink Manager allow for color mapping from one document to
another, or from an imported image to a document (see section
8.1.7: “Shortcut to documents from the light table”). 

1.2.9 Output

inpO2 Output module allows for PDF or JDF output. 

The Output module offers: 
• Easy to use main dialogue (see section 9.1: “Main Output 

Dialogue”)
• Multiple configurations to adapt to any PDF or JDF workflow (see 

section 9.2: “Configuring Output Properties”)
• Selection of any inpO2 profile for output (see section 2.4: 

“Profiles”)
• Options for PDF format (see section 9.2.1: “PDF Output Options”)
• Options for JDF format (see section 9.2.2: “JDF Output Options”)
• Flat grouping and file naming (see section 9.2.3: “Grouping and 

Naming Files”)



1 Introduction — Preferences • 13

Release: November 20, 2012

1.3 Preferences

1.3.1 Acrobat Preferences

Acrobat preferences can be set in Edit > Preferences menu. Two cate-
gories are important to mention in relation with inpO2: Units &
Guide and Document.

Units & Guides The default measurement unit should be set before starting building
projects. 
• Click on Units & Guide in the Categories list
• Select the desired default measurement units in the Page & Ruler 

drop list.

All measurements can be set in inches (in or "), points (pt), picas
(pc), centimeters (cm) or millimeters (mm). Simply write the correct
abbreviation. Upon entering a value without a unit, inpO2 will use
the default measurement unit. 

You can also enter values using any other unit of measure supported
by Adobe Acrobat.

When a measurement unit other than the default unit is entered,
the value will automatically be recalculated to be displayed in the
default unit.

Document For Windows users only:
• Select Document in the Categories list.
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• Uncheck the first option in the right panel: Show each document 
in its own window (requires restart).

• Restart application.

Failing to perform these steps may cause problems while using inpO2
with a Windows operating system.

1.3.2 inpO2 Preferences Dialogue

The inpO2 Preferences dialogue allows for configuring global settings
for the application. It can be accessed from Edit > Preferences menu,
or directly from inpO2 main menu.

• Enable Network Protection Key Research at Startup: This option 
will search on your entire network for a network license if no 
hardware key is connected on your workstation. For faster 
Acrobat startup, this option should remain unchecked unless you 
use inpO2 network license.

• Use Advanced Assembly Wizard: The advanced wizard of the 
Assembly Manager offers more panels for complex assemblies (see 
section 4.3.5: “Insert Wizard”). 

• Bleed Document over Reference Marks: Checking this option will 
layer up the bleed over all reference marks (trim and bleed marks, 
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sheet center marks, register marks and fold marks). The marks 
will thus be clipped at page bleed (if option is selected) or at page 
trim (if option is not selected). 

• inpO2 Opening Profile: A built-in or custom profile can be selected 
as a default profile that will apply each time a new job is created 
or opened. 

• Apply Creep Compensation on: The creep compensation adjustment 
can be done on page trim or on page content, thus page marks 
will “move” or not with the adjustment (see section 4.5: “Creep 
Compensation”). 

• Ruler Origin: The ruler of the light table can be positioned on the 
bottom left corner of the plate, or on the corner of the sheet (see 
section : “Using the Rulers”).

• Maximum Job Identifier: A limit number can be set for the counter 
to identify jobs (maximum of 10 digits). When this limit is 
reached, the counter restarts at 1 (see section 1.6.5: “Job 
Identifiers”).

• Reset windows to their default position: This function can be used 
to reposition all inpO2 windows at their default location.

• Restore disabled warning messages: This function resets all 
recurring warning messages that were disabled by the user.

1.3.3 inpO2 Preferences Files

Presets and display
options

inpO2 uses many preference files (.ctlg) to remember the Presets
defined by the user. These Presets may be objects properties, page
group definitions, press characteristics, paper properties and much
more. 

User customization of the workspace such as size and position of
dialogues, last used paths, last used profile, etc. are also saved as
preferences.

Languages inpO2 is available in various languages which may be selected in the
inpO2 menu under Language options. The default interface language
is the same as the Acrobat interface language. If Acrobat is installed
under a different language in which inpO2 is not available, the
default language will be English. After changing the language option
of inpO2, Acrobat needs to be restarted for the changes to take
effect. inpO2 will then appear within Acrobat in the language
selected, independently from Acrobat’s language.Light Table Basics

When creating or opening a layout, inpO2 displays a light table as a
“what you see is what you get” (WYSIWYG) interface.
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1.4 Layout Geometry
When working on the light table, inpO2 can display a comprehensive
set of layout data and outlines to help building the imposition. This
information can be shown or hidden via the Profiles dialogue (see
section 2.4: “Profiles”).

1.4.1 Anchors and Offsets

Most objects in inpO2 can be positioned on the sheet using an
anchor and an offset value.

All objects in inpO2 have 9 anchor points.

Whenever an object is selected, the object’s parent is also selected.
Anchor points are given different shapes: squares are used for the
child and diamonds for the parent. The position of the child is
always given in relation to the selected anchor point of the parent.
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Offset values can be horizontal (X offset) or vertical (Y offset).
• A positive X offset moves the object to the right.
• A negative X offset moves the object to the left.
• A positive Y offset moves the object up.
• A negative Y offset moves the object down. 

When positioning an object, you must first decide on the anchor
points of both the parent and the child, then choose an offset. Any
of the anchor points can be selected simply by clicking on it. The
default anchor point is the center. 

Anchor points also act as reference points to snap objects when plac-
ing them on the light table (see section 2.1.2: “Positioning an Object
on the Light Table”).

1.4.2 Plates, Sheets and Sheet Marks

Plates and sheets are PDF surfaces and cannot be moved or selected.

X=0
Y=0

X+

Y-

Y+

X-
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The plate is the largest surface on the light table and contains all
other objects placed on it. If there is no plate configured, the sheet
becomes the largest surface and contains all other objects on it.

Sheets can display vertical and horizontal center marks as well as
the sheet’s corner marks (visible only when a plate is configured).

Horizontal and vertical sheet center marks are located in the center
of each side. Center marks cannot be selected or moved. They can be
used as guides to snap objects.

Plates, sheets and sheet marks are configured via the Sheet Proper-
ties dialogue: (see section 1.5: “Sheets and Plates”).

1.4.3 Flip Axis / Work Style

The back side of the layout is managed at the plate level (or at the
sheet level when no plate is configured) by selecting a flip axis. A
preconfigured work style can be selected if preferred. 

Flip Axis When selecting a flip axis, the work style drop-menu will be dis-
abled.
• None means there is no back to the plate or sheet.
• Vertical Axis means the sheet is flipped around a vertical flip axis 

(left to right) to print the back. 
• Horizontal Axis means the sheet is flipped around a horizontal flip 

axis (top to bottom) to print the back.
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Work Styles A specific Work Style can also be selected. Possible values are:
• Simplex – No turning
• Work And Back – The most common method for printing the back of 

the sheet. The front is printed, then the sheet is turned from left to 
right on a vertical flip axis to print the back. Also refered to as 
Sheetwise.

• Perfecting – Method for printing the back of the sheet. The front is 
printed, then the sheet is turned from top to bottom on a horizontal 
flip axis to print the back.

• Work and Tumble – To print one side of a sheet of paper, then turn 
it over from gripper to back using the same side guide and plate 
to print the second side.

• Work and Turn – To print one side of a sheet of paper, then turn it 
over from left to right and print the second side using the same 
gripper and plate but the opposite side guide.

1.4.4 Gripper Area

The gripper area is defined on the sheet and not on the plate. On a
press sheet, the gripper is a non-printable area. It is the part of the
sheet that will be grabbed by the printing equipment to move the
sheet through the press. 

The gripper area is represented on the light table as a rectangle. This
rectangle helps the positioning of objects on the sheet, but is not
meant to be part of the final output although it can be printed for
proofing.

When working on a sheet with a horizontal flip axis, the option of
showing the position of the inverted gripper on both sides of the
sheet is available, in order to position objects inside the printable
area. In this case, two rectangles on the sheet will be displayed,
showing where the gripper areas are located. This is especially useful
when working with a perfector press.

The gripper and the gripper size may be set via the Sheet and Plate
dialogue (see section 1.5: “Sheets and Plates”).

Gripper zone without inverted 
gripper on back

Gripper zone with inverted 
gripper on back
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1.4.5 Page Group, Gutters and Margins

A page group is made of one or many pages, page marks, gutters and
margins:
• The pages are the placeholders of source documents.
• Page marks are marks associated to pages: trim and bleed marks.
• Gutters are the spaces between pages.
• Margins are the spaces around the page group.

Gutters can contain marks such as fold marks, imported marks and
density bars. 

A margin is a space outside of the page group, all around the sheet.
Every gutters and margins can have different values.

Horizontal gutter

Vertical gutter

Page

Fold mark

Bleed mark

Trim mark

Bleed1

Vertical Margin

Horizontal margin
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1.4.6 Page Information

In inpO2, each page on the light table displays information related
to the current imposition.

• TrimBox Outline: This frame indicates the size and position of the 
trimmed page (excluding the bled).

• Page head: The top of the page is identified by the orientation of 
the T symbol (see “Page Head“ in the glossary).

• Folding number: This number on the page is taken from the 
folding pattern and shows how the page group will be folded after 
being printed (see “Folding Numbers“ in the glossary).

• Imposition index number: This number is the actual number of the 
page in the publication and corresponds to the run list. 
Imposition index numbers are incremented based on the assembly 
and/or the selected folding (see “Imposition Index Number“ in 
the glossary).

• Section: The sheet Section is identified by a letter, A, B, C, etc. 
(see “Sections“ in the glossary).

• Source file information: The Source file information displays the 
file name and page number of the document that will be printed. 

• Product Part Name/Assembly name: This name is given by the 
Layout Manager or by the Assembly Manager and can be 
customized. 

• Product Part Color: If this option enabled in the Profiles dialog, a 
different color code is given by the Layout Manager to each 
product part, in order to ease job ganging. 

• Creep amount and adjustment: On the layout, the arrow shows the 
direction of creep and the number in the arrow shows the amount 
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of creep that will be applied to that page. (see “Creep“ in the 
glossary). 

All the above page information can be shown or hidden via the Pro-
files (see section 2.4: “Profiles”).

1.5 Sheets and Plates
In inpO2, the Sheet represents the paper surface of the press sheet.
The Plate represents the physical plate or the film surface. The use of
Plates is optional. 

The sheet fed or web press that will print the publication determines
both plate and sheet size.

1.5.1 Plate & Sheet Presets

When creating a new layout, the very first step is to define the sheet
and the plate formats.

Sheets and Plates can be defined and saved using Presets (see section
2.5: “Presets”). 

Once the layout is created on the light table, sheets can be added by
using the Insert Sheet option in the inpO2 menu (see section 1.5.3:
“Inserting a Blank Sheet”). 

Sheet Sheet options define the sheet’s format, style and symmetry behav-
ior, gripper display options, non-printable margins sizes and side
guides/sheet guides preferences.

Index number

Folding number

Product Part/Assembly name

Source file information

Page head

Creep amount and direction

Section

Trimbox Outline

Product Part Color
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• Define Back: inpO2 offers two different ways to define the back. 
- By using a flip axis: 

> Back Side option is available. Choose the flip axis for the cre-
ation of the back side (see section 1.4.3: “Flip Axis / Work 
Style”)

- by using a work style: 
> Work Style options are available. Choose the needed work-

style from the list.

Work Styles Work Style options allow the selection of the type of symmetry used
between the front and back side of the sheet, which depends on the
way the paper will pass in the press (see section 1.4.3: “Flip Axis /
Work Style”).

Gripper Edge on Front: Choose among the four possible locations for
the gripper (Bottom Edge is the default). If no gripper is needed,
choose None.

- Size: Enter the width of the gripper area.
- Inverted Gripper on Back: This option may be selected for per-

fecting presses that grip the sheet on two opposite sides to 
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print the back. This option will display both front and back 
gripper areas on the sheet.

Non-Printable Margins: Define the desired width of the non-printable
margins for each sheet edge, Left, Top, Right, Bottom. See also 2.1.2:
Positioning an Object on the Light Table.

Side Guides/Sheet Guides: Check the box to place guides on each side
of the sheet. 

- Image: A drop down list lets you choose a predefined image or 
select a PDF file containing the image that will be used. You can 
save your setting as with other Presets; see section  2.5: “Pre-
sets” and section  3.1.2: “Imported Image Presets”.

- Guide Locations: choose between Top, Bottom or both.
- Follow WorkStyle on Back: Guides may follow or not the work 

style (turning axis of the sheet) to comply with various perfect-
ing press requirements. 

- Distance from Gripper: enter the value for the offset distance 
from the gripper edge.

- Offset from Bottom: enter the value for the offset distance from 
the bottom of the sheet.

- Offset from Edges: enter the value for the offset distance from 
the edges of the sheet.

- Offset Direction: the direction, Outward or Inward towards which 
the offset will apply.

Center Marks: Options are available to create center marks on the
sheet. Top and Bottom marks and/or Left and Right marks can be
enabled. These marks will be centered on the sheet (see section 1.4:
“Layout Geometry”).

Plate Plate options define the size of the plate and the position of the
sheet on the plate. The use of plates is optional. 
• Use Plates: To activate plate settings, check the selection.
• Width and Height: Set values using any measurement unit.
• Sheet Alignment on Front: To accommodate plate folds and 

punches, an alignment and offset on the plate of each sheet side 
can be defined. Choose anchor points for the position of the sheet 
on the plate.
- Horizontal Offset: Enter a positive or negative value to move the 

sheet right or left on the plate.
- Vertical Offset: Enter a positive or negative value to move the 

sheet up or down on the plate.
• Sheet Alignment on Back: same as above, plus the choice Same as 

Front.
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1.5.2 Sheet Format Presets

Sheet Formats presets are used through the Wizard dialogue. They
can be defined and saved using the inpO2 Presets (see section 2.5:
“Presets”). 

The Sheet Format Presets window is available from the inpO2 > Pre-
sets > Sheet Format menu.

Properties Sheet Format properties options define the width and height only.
The other aspects that may relate to the sheet (position, offset,
marks, etc.) can be set via other objects.

Width and Height: Enter the new value of the sheet format.

1.5.3 Inserting a Blank Sheet

When there is no sheet on the light table, a new layout must first be
created using Create inpO2 > Layout from Acrobat’s File menu. The
Plate and Sheet dialog opens.

A preset can be selected in the list, created, duplicated or modified
by changing and saving its properties (see section 2.5: “Presets”).
When clicking on Insert Sheet button, the sheet (PDF page) is cre-
ated on the light table.

Once the first sheet is created, additional empty sheets can be added
in the layout via the Insert Sheet option in the inpO2 menu, or using
the Insert Sheet button in the toolbar. The new sheet will be added
after the current sheet.

1.5.4 Deleting a Sheet

Remember that sheets or plates are PDF pages in Acrobat. To delete a
sheet, click on the Pages panel tab at the left of the Acrobat window
so that sheet thumbnails can be previewed. 

Select the sheet to delete from the layout and press Delete. A warn-
ing will request to confirm deletion. When clicking on OK, the Front
and the Back of the sheet will be deleted. 
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It is not possible to delete all sheets from a template. A warning
message will be displayed and a disabled page will appear.

Important Sheets from an Assembly Project (*.ably) must be deleted from the
Assembly Manager interface (see section 4.3.2: “Inserting and Remov-
ing Templates”). 
Sheets from an Managed Layout (*.mlay) must be deleted from the
Layout Manager interface (see section 5.2.1: “Press Runs Tree Struc-
ture”).

1.5.5 Copying a Sheet

While the Assembly Manager or the Layout Manager are the right
tools for copying sheets for bound jobs requiring page incrementa-
tion, the Copy Sheet function allows for easier building of multi-
sheet templates or different other commercial jobs.

inpO2 offers the ability to copy a sheet with all its contents, directly
from Acrobat’s page thumbnails with the usual Ctrl+Drag action
(Alt+Drag on MacOS). When dropping the thumbnail, a duplicate
sheet is created, front and back, with all pages and marks that can
be further edited on the light table. If the sheet is not added in the
right order, it can be moved up or down with a click and drag.

Notice that pages on the sheet are not automatically repaginated.
This will have to be done manually if required.

1.6 Page Groups 
A Page Group is a grouping of pages that may form a signature, part
of a signature or a step and repeat layout (see “Page Group“ in the
glossary).
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A Page Group is made of pages, page marks, gutters and margins (see
section 1.4.5: “Page Group, Gutters and Margins”).

1.6.1 Page Group Presets

The Page Group Presets dialogue box is accessible through the Presets
drop menu of the Objects toolbar (arrow near the Page Group icon) or
by selecting Presets > Layout Objects > Page Group from inpO2’s main
menu.

Page Groups can be defined and saved using Presets (see section 2.5:
“Presets”). They can also be edited on the light table using Object
Properties palette (see section 2.3: “Object Properties Palette”).
Please refer to these sections for general information about the cre-
ation of presets and edition of objects on the light table. 

Structure Structure defines the configuration of the page group.
• Columns and Rows: Enter how many Columns and Rows of pages 

the page group will hold. 
• Page Orientation: This option defines the orientation of the pages, 

whether page heads will be placed Upright or Lateral on the sheet.

Pages Pages options allows selecting page size and marks.
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• Page Format: This field displays the selected Page Preset. Another 
preset can be selected in the drop list. To create a new Page Preset 
click on the “...” button at the right of the drop list (see section 
1.6.2: “Page Format Presets”).
- Aspect: Portrait or Landscape can be selected to describe the use 

of the page format. 
• Bleed: Bleed values can be set for the four sides at once. 

Expanding the node will display individual controls for the four 
sides.
- Left becomes the Spine for bound works.
- Right becomes the Face for bound works. 

• Bleed Marks 
- Length: Sets the length of the individual mark.
- Thickness: Sets the line weight of the individual mark.
- Offset from Bleed: A value can be given to offset the mark from 

the bleed edge. If the bleed value is equal to zero, an offset 
should be given to avoid page overlap.

• Trim Marks: They share the same settings as Bleed Marks (see 
above).

• Show All Corner Marks: This option is useful for step and repeat 
page groups to place page marks in all gutters. If not selected, 
page marks will appear only on the edge of the page group.
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Gutters Gutters options define the gutters of the page group and their fold
marks. Note that the properties of individual gutters can be modi-
fied with more precision using the Gutters Object Properties dialogue
(see section 1.6.4: “Gutters, Fold Marks and Margins”).
• Horizontal and Vertical: Set the width for the horizontal and 

vertical gutters. 
• Fold Marks: Check to display fold marks in the gutters. 

Margins Margins options define margins around the page group. Note that
the properties of individual margins can be modified later using the
Margins Object Properties dialogue (see section 1.6.4: “Gutters, Fold
Marks and Margins”).
• Horizontal and Vertical: Set the width for the horizontal and 

vertical margins. 

1.6.2 Page Format Presets

Page Formats are used though the Page or Page Group dialogues and
from the Layout Manager. 

Page Formats can be defined and saved using Presets. Please refer to
this section for general information about the creation of presets
(see section 2.5: “Presets”). 

The Page Format Presets window is available from the inpO2 > Presets
> Page Format menu. It is also available through the Page Group Pre-
set or within the Layout Manager dialogue by clicking on the “...”
button at the right of the Page Format drop list. 

Properties Page Format Properties options define the page size only. The aspect
(portrait or landscape) can be set though the Page Group or in the
Layout Manager. The most frequently used page formats are included
with the installation. 

- Width and Height: Enter the new value of the page format (trim 
size).
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1.6.3 Individual Pages 

Individual pages can be added on the layout by creating a one by
one page group.

However, individual pages within a page group can be edited on the
light table by Shift-clicking on the page. The Object Properties pal-
ette will offer the following options for page edition.

• Page Format (see section 1.6.2: “Page Format Presets”)

• Bleed

• Bleed Marks

• Trim Marks

• Show All Corner Marks.

All these settings are similar to those defined for the page group
(see section 1.6.1: “Page Group Presets”).

1.6.4 Gutters, Fold Marks and Margins 

To edit margins or gutters on the light table, hold Shift and click in
the gutter with the Object Selection Tool, then double-click, or right-
click (Ctrl-click on Macintosh) on the selected margin or gutter and
choose Properties from the contextual menu.

Editing a Gutter The Object Properties palette will offer the following options for gut-
ter edition.

• Total Width: Enter the total distance from page trim to page trim.
- First Half and Second Half: In case of asymmetrical gutter, enter 

the width of the first and second halves. This will result in an 
offset of the fold mark.
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• Fold Marks: Fold marks are dotted lines that indicate where the 
booklet will be folded.
- Visible: If checked, fold marks will be placed at the center of the 

gutter, or will respect the gutter asymmetry if defined.
- Length: Enter the length of the fold marks.
- Thickness: Enter the line weight for the marks.
- Offset from Edge: An offset can be given to move the fold marks 

away from the edge of the page trims.

Editing a Margin The Object Properties palette offers only one option: the Total Width.
51

1.6.5 Job Identifiers

Job Identifiers are optional and can be used for various workflow
requirements. 

For example, they can be used in text marks or barcodes to set a
value for the <JobID> variable. 

The Set Job Identifier dialog is directly accessible from the inpO2
main menu. It displays all the jobs available in the current project. 

• For layout and assembly projects, there will be only one entry. 

• For managed layout projects, there will be one entry for each 
press run.

Using generated ID The default value for job identifiers is automatically generated by
inpO2. Each time a job is created, an ID is assigned following a
sequence that starts a 1 and ends when the limit set in the Prefer-
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ences is reached (see section 1.3.2: “inpO2 Preferences Dialogue”).
Then the sequence starts over.

Using manual ID It is also possible to override the assigned sequence number by
entering a value in the Set Job Identifier dialogue.

For example, if the barcode encoding type doesn't support the gener-
ated ID because it has too many digits, a checkpoint error will be
shown on the light table and at output. It is then possible to change
the value to something valid using this dialogue.
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2 Light Table 
Tools
This chapter gives details about to the tools that are provided to
manipulate the objects on the light table. 

The tools used are mostly the ones contained in the inpO2 Tools tool-
bar:
• Object Selection Tool
• Pagination Tool
• Object Properties Palette
• inpO2 Profiles 

2.1 Object Selection Tool
The Object Selection tool is the default inpO2 tool. It is used to select
any object on the light table. When combined with other keyboard
keys and tools, the tool allows to move, edit and delete objects as
needed. 

2.1.1 Adding an Object on the Light Table

Each object is represented by an icon on the Objects toolbar. Click on
the icon of the Object that you want to add to the sheet.

Notice that the object’s icon currently selected in the toolbar is
shaded in blue.

The curser will change shape to further indicate which object is cur-
rently selected. Click on the sheet and drag the object to position it
on the sheet. When the mouse is released, the selection in the tool-
bar returns automatically to the Object Selection tool.

Note Some objects can not be added unless they are previously defined or 
have their parent object already on the sheet. 

2.1.2 Positioning an Object on the Light Table

When adding an object on the light table, the outline of the object
can be dragged on the sheet as long as the click isn’t released. How-
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ever, this would provide only an approximative positioning of the
object. There are a number of tools that can be used to help the user
be more precise in positioning objects. 

Also take note that certain areas on the sheet, such as the gripper
area and non-printable margins, are forbidden zones, that is, unus-
able for printing purposes. Checkpoints will report objects in these
zones and outputs may throw warning messages.

Using the Snap The positioning of objects on the light table is facilitated by the
snap action. The snap acts as a magnet to precisely align the center
or border of an object to the ruler guides, to the center or border of
the sheet or to the center or border of other objects (see section
1.4.1: “Anchors and Offsets”). The snap is activated by default but
may be disabled by unselecting menu item inpO2 > Snap to Objects.

To align an object with other objects on the same sheet, drag the
object until dotted lines appear between your object and the ones to
which it should be aligned. Then release your click and the mark is
placed in the right position.

Some marks such as collating or imported marks will also snap at
their natural position in their parent gutters.

Using the Rulers Rulers are other tools that can be used to help positioning an object
on the light table. Rulers may be shown or hidden via the inpO2 >
Show/Hide > Rulers menu. 

If the default ruler origin is set to Sheet Lay Corner in the inpO2
preferences (see section 1.3.2: “inpO2 Preferences Dialogue”) the
zero location of the rulers will be at the left edge of the front sheet
and the rulers will follow the flip axis on the back sheet.
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If the default ruler origin is set to Plate Bottom Left Corner in the
inpO2 preferences, no symmetry is applied to the ruler on the back
side.

The rulers origin may be shown or hidden via the inpO2 menu by
choosing Show/Hide > Rulers origin. 

The rulers origin may be moved anywhere on the sheet as guides to
help position objects. Objects will snap to these guides.
• Click and hold within the square intersection (shown in yellow 

below) located at the junction of the vertical and horizontal 
rulers at the bottom left corner of the sheet. Using the mouse, 
drag the rulers to the specific location where it is needed. The 
zero point will be dropped at the tip of the cursor position and 
guides will appear as fine gray lines (see section 2.1.2: 
“Positioning an Object on the Light Table”).

Front Sheet

Front Sheet

Back Sheet
Vertical Flip Axis

Back Sheet
Horizontal Flip Axis
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• When the Rulers origins are visible, click where the two lines cross 
and drag anywhere on the sheet.

To clear the ruler origin, double-click in the square intersection at
the junction of the rulers, or drag the zero point back to its original
position.

You can configure the default origin of the rulers via the Acrobat
menu Preferences | Edit Preferences | inpO2 Preferences.. and then
choose between Plate Bottom Left Corner or Sheet Lay Corner.

The most precise way to position an object is by using the Object
Properties palette (see section 2.3: “Object Properties Palette”).

2.1.3 Selecting and Moving an Object

To select an object, make sure the Object Selection tool is active and
click on the object or draw a selection box around it. 
• To select multiple objects, hold Ctrl while clicking on objects to be 

added to the selection.
• To move a selected object, drag it to its new position. While 

moving the object, only the outline will move, allowing to view 
where it will be dropped compared to its original position. The 
object will be positioned upon releasing the click.

• To release the selection, click anywhere outside the object.
• To select an object within a page group:

- A single page, a gutter or a margin are part of a page group. To 
select any of those, press Shift while clicking on the object.

- For multiple selections of similar objects (multiple pages or mul-
tiple margins/gutters), press Ctrl + Shift while clicking on the 
object to be added to the selection.

- There are two ways to access the contextual menu of an object 
within a page group: one way is to first select the object and 
then right-click on it. The second way is to press Shift + right-
click.
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2.1.4 Editing an Object

Make sure the Object Selection tool is active and click on the object
or draw a selection box around it. 
• Double-click on the selected object or right-click (Ctrl-click on 

Macintosh) on the object and choose Properties from the 
contextual menu (see section 2.3: “Object Properties Palette”). 

• The Object Properties window will open. Changes are applied as 
they are entered and are reflected on the light table instantly.

2.1.5 Rotating an Object

You can rotate an object precisely with any angle by using the Object
Properties palette (see section 2.3: “Object Properties Palette”). It is
also possible to quickly apply a 0, 90, 180 or 270 degree rotation
value to an object from its contextual menu.
• Make sure the Object Selection tool is active. 
• Right-click (Ctrl-click on Macintosh) on the object and choose 

Rotate from the contextual menu. 
• Choose a rotation angle in the menu. The object will be rotated 

on the light table.

2.1.6 Deleting an Object

Make sure the Object Selection tool is active and click on the object
or draw a selection box around it. 
• Press the Delete button on the keyboard or right-click (Ctrl-click 

on Macintosh) on the object and choose Delete from the 
contextual menu. 

• The object will be deleted.

2.2 Pagination Tool
inpO2 allows paginating manually by entering each page number, or
by selecting an existing folding pattern from the Presets.

2.2.1 Manual Pagination

Page numbering and page head orientation may be set manually
using the Pagination tool in inpO2’s Tools toolbar. 

Once completed, the pagination can be saved as a folding Preset (see
section 2.2.2: “Page Group Folding”).
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Numbering Select the Pagination tool. The mouse pointer will change to #.

To paginate a layout, click directly on a page and type in its new
page number. Press Enter or Tab to apply the value and move to the
next page in the page group. 

By default, inpO2 will paginate the other side of the page automati-
cally. To paginate on one side only, unselect the option Automati-
cally Paginate Back found in the tool’s drop menu (small arrow near
the icon).

Several pages can be paginated at once by selecting them with the
Pagination tool and entering the page number. To select many pages
using the Pagination tool, draw a selection box around the pages, or
use the Ctrl key to add pages to the selection. 

Setting Page Head While still using the Pagination tool, the orientation of the page
head can be changed by right clicking on a page and selecting Set
Page Head Up or Set Page Head Down in the page contextual menu. 

It is also possible to use the Page Up and Page Down keys of the key-
board.

To exit from the pagination mode, choose another tool in inpO2’s
Tools toolbar.

2.2.2 Page Group Folding

inpO2 offers a selection of commonly used folding templates. It also
includes N-Up and Step and Repeat pagination styles. Any other fold-
ing may also be created and saved as a Presets. 

Applying a Folding The Folding Presets dialogue is accessible via the Fold option of the
Pagination tool menu. The mouse pointer will change to # and the
icon of the Pagination tool will turn into a folding icon. Click on the
page group on which the folding will be applied to access the Folding
Presets dialogue. The dialogue may also be opened by right-clicking
(Ctrl-click on Macintosh) with the Object selection tool on a page
group that is already created and choosing Select Folding from the
contextual menu.
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The Folding Presets dialogue displays the following areas:
• Items: lists all the available foldings. To select a folding, simply 

click on the desired item in the list. The information will then be 
updated in the other two areas.

• Preview: gives a visual representation of the page group (front 
and back) with a folding number on each page.

Once the proper folding template has been selected, just click on OK
to apply the pagination, or Cancel if you don’t want to apply it. In
either case, the dialogue closes to return to the light table.

Creating a Folding New foldings can be created and saved as Presets by following these
steps:
• Manually paginate a page group (see section 2.2.1: “Manual 

Pagination”).
• Right-click (Ctrl-click on Macintosh) on the page group and 

choose Folding in the contextual menu. 
• In the Folding Presets dialogue, click the Save and Apply button 

located at the top of the Items area and give a name to the new 
template to be saved as a Preset.

• The folding can be directly saved as a Preset by right-clicking the 
page group (Mac: Crtl-click) and choosing the contextual menu 
item Save Folding as New Preset.

2.2.3 Sheet Sections

inpO2 offers the ability to assemble sheet sections. To use this
advanced function, groups of pages in the template must be
assigned to different sections.

Notice that only symmetrical blocks of pages can be used as sections
by the Assembly Manager.
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First ensure that Section is selected in the current Profile (see section
2.4: “Profiles”). By default, all pages are part of section A.

To edit the section on a group of pages, select a group of contiguous
pages with the Object Selection Tool (to select many pages at once,
use the Ctrl-Shift keys).

Right-click on the selection to display its contextual menu. In the
Section menu item, select B (New Section) to change the section let-
ter of the selected pages.

If sections A and B already exist in the page group, C (New Section)
will be available, and so on, so that only consecutive letters are used
in the template.

Once the sections are set, the template can be exported and used in
the Assembly Manager (see section 4.4.7: “Use of Sections”).

2.3 Object Properties Palette
The Object Properties window can be accessed using its icon. Alter-
nate ways to open this window are to double click on any object on
the light table or by selecting inpO2 > Show/Hide > Object Properties. 

The Object Properties window always displays properties of the
selected object. 

This window serves two purposes:
• Modify the properties of the selected object (top portion of the 

window)
• Position or resize the selected object accurately on the layout 

(bottom portion of the window).
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2.3.1 Modifying Object Properties

The Object Properties window contains the same properties as you
will find in the Presets window of the corresponding object (refer to
each object’s section for details). 

The main difference between Presets and Object Properties is that a
change in the Presets window will affect all new objects of the same
type added to the light table, while changes in the Object Properties
window will only affect the selected object on the light table. 

To modify the properties in the Object Properties window, enter the
new value in the appropriate field and press Enter or click in another
field to apply changes on the layout. 

2.3.2 Positioning Objects Accurately

The Position and Size portion of the Object Properties window is very
useful to move, rotate or scale most inpO2 objects with precision. 

Type of object
selected

Selected object’s
properties

Selected object’s
position and size
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Most objects can be modified with the Object Property window by
editing different parameters:
• Anchor point. Once the Object Property window is opened, 

selecting any object on the light table will display the object’s 
nine anchor points. If not, make sure that inpO2 > Show/Hide > 
Selection Anchors is checked. The center anchor point is activated 
by default. Click on any other point to use it as the reference 
anchor point. The selected anchor point is displayed in red.

• Position (X: and Y:) gives the position of the selected object’s 
anchor point, based on the zero point of the rulers. Notice that 
the zero point of the rulers can be modified, see sub-section 
"Using the Rulers" of section 2.1.2: Positioning an Object on the 
Light Table.

• Offset (X: and Y:) gives the position of the selected object’s 
offset, that is the difference between its actual position and its 
expected position. These fields are not available for all objects.

• Scale (X: % and Y: %) gives the scaling factor of the selected 
object.

• Size (W: and H:) displays the size of the selected object on the 
layout. These fields are not editable.

• Rotation (R:) displays the rotation angle of the selected object in 
degrees (from 0º to 360º).

Placing an Object with X
and Y Coordinates

• Open the Object Property window. 
• Choose the Object Selection tool.
• Click on the object you want to position.
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• On the light table, identify the anchor point to use, that is the 
reference point of the object from which new coordinates will be 
entered. 

• Enter the new position values in the Object Properties palette.

• Press Enter and the selected object will take its new values.

Applying an Offset Some objects are children of their parent object and have a normal
position based on their parent configuration, for example an
Imported Mark placed in a gutter. For these children objects, an off-
set from their normal snap positioning can be applied.

An offset from the initial position can also be given to any type of
object, instead of placing it with coordinates. 

• Open the Object Property window. 

• Choose the Object Selection tool.

• Click on the object you want to position.

• Enter the new offset values. 

• Press Enter and the selected object will be positioned accordingly.

Notice that while the cursor is still in the offset field, an arrow is
drawn between the anchor points used for the positioning. The base
of the arrow shows the parent anchor point and the arrow head
shows the anchor point of the child object.

Scaling an Object In inpO2, any object from the layout may be scaled.

• Open the Object Property window. 

• Choose the Object Selection tool.

• Click on the object to scale.

• On the light table, choose the anchor point to use, that is the 
point whose position will not change when you apply the scaling.

• On the Object Property window, enter the new scale values in 
percentage. While the cursor is still in the scale field, an arrow 
indicating the direction of the scaling is drawn over the object on 
the light table.

• Press Enter and the selected object will be scaled accordingly.
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Rotating an Object In inpO2, any object from the layout may be rotated.
• Open the Object Property window. It is available from the inpO2 

menu, Show/Hide option or by clicking on its icon in the tool bar.
• Choose the Selection tool.
• Click on the object to rotate.
• On the light table, choose the anchor point to use, which will act 

as the pivot point. 
• Enter the rotation value in degrees (from 0º to 360º).

- Increasing the value will rotate the object clockwise around the 
selected anchor point.

- Decreasing the value will rotate the object counterclockwise 
around the selected anchor point.

• Press Enter and the selected object will be rotated accordingly.

2.4 Profiles

2.4.1 Understanding inpO2 Profiles

inpO2 profiles are used to define which elements are displayed on
the light table and/or sent for output. Since inpO2 is an entirely
WYSIWYG application, all objects and page information displayed on
the light table can also be printed. 

inpO2 has three preconfigured default profiles: inpO2 Working Pro-
file, inpO2 Proofing Profile and inpO2 Output Profile. These profiles
cannot be deleted or modified, but additional customized profiles
may be added. Customized profiles may be split into categories, such
as proofing and imaging, so they adapt closely to different job types
and devices.

2.4.2 Using Default Profiles

To select a profile, click on the arrow to the right of the Profile icon,
which opens a drop menu. The profile name with a check mark is the
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one currently selected. To use a different profile, select it in this
drop menu.

The inpO2 Working Profile displays a wireframe view of the layout. 

In addition to layout objects, the inpO2 Working Preview Profile also
displays low resolution page thumbnails and mark contents. It
should be used to optimize the speed when working with source doc-
uments. 

The inO2 Proofing Profile contains a mix of working and printing ele-
ments that can be used for imposition proofing. The pages displayed
are high resolution PDF documents.

The inpO2 Output Profile contains only elements that must be
printed on the sheet, and it should be used for final output. A short-
cut to the Profiles dialog is also available from the Output window to
ease the Profile selection.

inpO2 Proofing inpO2 OutputinpO2 Working inpO2 Working Preview
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The following table identifies items that are part of the four built-in
inpO2 profiles.

inpO2 Output 
Profile

inpO2 Proofing 
Profile

inpO2 Working 
Preview Profile

inpO2 Working 
Profile

Documents

Page Contents Complete Complete Preview None

Page Information

TrimBox Outline No Yes Yes Yes

Page Head No No Yes Yes

Folding Number No No No No

Section No No Yes Yes

Imposition Index No Yes Yes Yes

Document Information No No Yes Yes

Product Part Name No No No No

Product Part Color No No Yes Yes

Creep Compensation Value No No Yes Yes

Marks

Fold Marks Yes Yes Yes Yes

Linear Marks Yes Yes Yes Yes

Trim and Bleed Marks Yes Yes Yes Yes

Sheet Center Marks Yes Yes Yes Yes

Sheet Corners No No Yes Yes

Side Guides/Sheet guides Yes Yes Yes Yes

Gripper Area No No Yes Yes

Imported Mark Contents Yes Yes Yes No

Imported Mark Outline No No No Yes

Density Bar Contents Yes Yes Yes No

Density Bar Outline No No No Yes

Register Marks Yes Yes Yes Yes

Collating Marks Yes Yes Yes Yes

Text Marks Values Values Values Variables

Barcode Contents Yes Yes Yes No

Barcode Outline No No No Yes

Layout Ink

Name LayoutOutline LayoutOutline LayoutOutline LayoutOutline

Ink Customized Customized Customized Customized

Cyan 96 96 96 96

Magenta 66 66 66 66

Yellow 0 0 0 0

Black 0 0 0 0
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2.4.3 Customizing Profiles

To open the Profiles Presets window, click on the Profiles icon in the
toolbar, click on Presets appearing as the last item in the drop menu,
or choose the inpO2 > Presets > Profiles menu.

The Profiles window is divided in two areas: Items list and Profile
options. The dialogue shares the same basic functions as other Pre-
sets (see section 2.5: “Presets”).

Documents The Documents group is used to define how source documents will be
displayed.
• Preview Page Contents: Selecting Preview in the drop menu will 

use low-resolution page thumbnails for quick display when 
working on the light table.

• Complete Page Contents: Selecting Complete in the drop menu 
displays the high resolution PDF document. The display may 
require considerable amounts of time, especially when working 
with heavy files. Pressing the Esc key interrupts the refreshing 
process. 

Page Information The Page Information group is used to define various information
related to the page (see section 1.4.6: “Page Information”).

Marks The Marks group is used to show or hide printer’s marks. 
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• Imported Marks and Density Bars have separate controls for their 
contents and outline.

• Text Marks can display Variables, Values or None. On the layout, 
values are refreshed only at output or when the sheet must be 
redrawn by the application.

Layout Ink The Layout Ink is an additional ink to display and print (or not
print) all items found in the Page Information section of the Profiles
window. If used for output, this ink will create as a spot color on a
separate plate.
• Name: The default ink name is LayoutOutline. Any other name 

may be entered to adapt to a specific workflow.
• Ink: The default color used for the layout objects is blue, but it 

can be changed by choosing a RGB model in the Ink drop list or by 
entering a recipe in the Cyan, Magenta, Yellow and Black fields. 

2.5 Presets

Presets are used extensively to store, define and modify a great num-
ber of resources in the application. They can be used from the light
table, from the Wizard or from other modules. 

The following Presets are available from inpO2 > Presets menu.
• Layout Objects:

- Plates/Sheets, 
- Page Groups, 
- Imported Marks (and Imported Images), 
- Text Marks (and Text Expressions), 
- Bar codes
- Collating Marks, 
- Register Marks (and Register Mark Groups), 
- Density Bars, 
- Linear Marks
- Foldings

• Equipment:
- Presses
- Papers
- Page Formats
- Finishing Methods

• Others:
- inpO2 Profiles
- Output Configurations

Accessing Presets from inpO2 main menu allows for the creation and
edition of preset items. 

The layout objects Presets can also be accessed from the inpO2
Objects toolbar, by clicking on the small arrow located on the right
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of a specific object icon. A drop menu shows the list of the available
items. When an item is selected, it can be placed on the light table.
The last menu item called Add/Edit Presets gives access to the
object’s Presets dialog.

Object parameters can also be edited on the fly using the Object
Properties palette (see section 2.3: “Object Properties Palette”).

2.5.1 Presets Dialogues

All Presets windows share the same characteristics. The window gen-
erally has two areas. 

1. To the left, a list of available presets and control icons that allows 
to create, duplicate, rename, lock, import/export or remove items 
in the list.

2. To the right, a grid of properties, to view or modify parameters of 
the selected item.

Display Preferences Presets dialogues can be resized and positioned for the convenience
of the user. These settings are automatically saved as a preference.

The resizing can be applied to the window itself or the areas within
by moving the splitter. Just move your mouse on the edge of the
window or on the splitter, and when the shape of the cursor changes
click and drag to the desired location.

It is important to know that the resizing of a window area can go as
far as hiding the area. In this case, the splitter is still available to
reopen the area. 

Properties Properties are presented in a grid with a tree structure. The nodes
can be expanded or collapsed by clicking on the + or - icon located
to the left of the item. 

To ease the user experience, all editable fields have a white back-
ground while non-editable fields have a gray background. 

Some controls may be hidden until clicking on it. The following con-
trols can be found in the grid:

• Check boxes. A simple click on the check box will toggle the 
selection from one state to the other.

• Text boxes. They are used to key in the required information.

• Spin boxes. They allow the user to either enter the value with the 
keyboard, or use the up/down arrows to the right of the field to 
increase or decrease the value.

• Drop menus. They expand to give access to different attributes.

• Drop lists. They expand to give access to a list of predefined 
items. A button usually displays to the right to access a sub-
dialogue where these items can be edited.
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Tooltips display when the mouse cursor is positioned over a field for
about one second.

2.5.2 Editing Presets 

All objects have a Default preset which cannot be removed. 

Generic Presets are also installed with inpO2 to ease the learning of
the application. Those can be removed.

The procedure to modify the list of items in a Presets dialogue is
always the same.
• To create a new Preset from the presets dialogue, click on the 

Create New Item icon, at the top of the left pane. Some presets 
can also be created from the object’s contextual menu on the 
light table.

• To duplicate a Preset, select any item in the list and click the 
Duplicate Selected Item icon. Choose a name for the duplicate and 
click OK. 

• To rename an item, select it in the list and click on the Rename 
Selected Item icon (pencil). Enter the new name and click OK. If 
the name is already used for another item in the list, inpO2 will 
offer you to overwrite this item.

• To restrict a preset item to read-only operations, thus preventing 
accidental changes, press the lock icon.

• To import/export presets, use the tools in all Presets dialogues, or 
use the global exchange function (see section 2.5.4: “Exchanging 
Presets”).

• To remove a preset item, select it in the list and click on the 
garbage can icon.

You save the modifications to the new or existing presets by clicking
the button Save and Use at the lower right panel.

If you exit the presets dialogue by clicking the Cancel button, all the
changes you made will be lost.

2.5.3 Preset properties capture and save

Anytime you need to capture, rename and save an object’s preset
properties (for example, when working with unknown files), open
the object’s properties dialogue and look for the properties with the
“...” button. Click this button, which will open the presets dialogue.
In the left pane, an item named “untitled” with a sequence number
will be highlited. Rename and save the object for future reference.
You can thereafter browse the preset’s properties.
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2.5.4 Exchanging Presets 

All inpO2 Presets can be exchanged between workstations using
Export and Import functions. 

The Import or Export can be done for one type of object (Sheet,
Imported mark...) or globally for all user Presets.

All Presets To export all Presets from a workstation, go to the menu inpO2 >
Add/Edit Presets > Export Presets. Create a folder with a meaningful
name to save presets and click OK. The presets file names must never
be changed.

To import saved Presets from another workstation, go to the menu
inpO2 > Add/Edit Presets > Import Presets. Select the folder and click
OK. 

Imported Presets can either replace existing ones or can be merged.
Should a different Preset with the same name exist, the conflict will
be detected and a suffix will be appended to the name.

Single Object Presets Specific object Presets can also be exported from the corresponding
Presets dialogue, using Export and Import icons above the list.

2.6 Export Template for ATM

You can export a layout (*.layt) as an ATM template from the Acro-
bat file menu Export inpO2 > Template for ATM... (see “ATM“ in the
glossary). 

Your template will therefore be compatible with the :Apogee Pre-
press software from AGFA. Keep in mind that the .tpl file you are
about to create will be opened in an Apogee environment. The infor-
mation that you provide via the template properties will indicate
how the dialogue will be displayed inside the Apogee Template Man-
ager and used for the signature assembly (see section : “The ATM
Template Properties Panel”). 

Before exporting the ATM template, inpO2 will first validate the con-
tents of the layout and display a checkpoints list, if incompatibili-
ties are detected (see section : “Layout validation checkpoints”).
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The following table shows equivalent concepts between Apogee and
inpO2.

Remember that even if your layout objects are exported successfully,
some of their properties could be ignored because of their incompat-
ibility (see section : “Table of inpO2-ATM objects matching”).

The ATM Template
Properties Panel

The ATM template properties window will be displayed when you
export a layout as an ATM template.

Consider this panel as an advanced properties editor. Here, you will
fine tune the metadata that Apogee will use to prepare the building
blocks for the job to output. The properties of the template, signa-
tures and sheets can be edited.

Template The first node, in the left panel, is the template level. It is named by
default after the inpO2 layout’s name. Four editable properties are
found on the right section of the window:

• Template Name: the name you choose for that template.

• Binding Style: since you are in layout mode in inpO2, the Binding 
Style has not been defined yet. Choose from the following choices:
- Flat Work
- Perfect Bound
- Saddle Stitch
- Come and Go
- Cut and Stack

Apogee inpO2

Template When exporting an ATM template, the active inpO2 
layout is used with all signatures and sheets.

Signature Same concept but called Booklets in inpO2 
Assembly Manager.

Press sheet Sheet

Imposition Page Group

Independent 
page

1 X 1 Page Group
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• Partial Signature Position: select First, Last, From First or From 
Last

• Partial Signature Index: enter the index value. Zero resets the 
Partial Signature Position to First.

Signature The Signature nodes appear at the next level in the template tree.
The number of sheets on the layout will change the number of sig-
nature nodes displayed. A signature contains two properties:
• Signature Name: the name you choose for that signature.

• Number of Webs: decide here if the template contains multi-web 
information.

.

If you decide to increase the Number of Webs, the number of sheets
of the current signature will increase. All sheets will move up the
tree and if the last signature becomes empty, it will be discarded. A
warning message will be displayed in such circumstances.

Sheet The signature node contains Sheet nodes. The sheet properties are
detected from the inpO2 layout and displayed for each sheet node.

There are two locked properties:
• Width and height.

Also, four editable properties are displayed:
• Work Style. Select from the drop-down list:

- Sheetwise
- Work and Tumble
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- Work and Turn. Only a half sheet is necessary on the inpO2 lay-
out, the other half will be added automatically.

- Single sided
- Perfector

• Side Guide offset: enter the distance from the side edge.
• Position of Side Guides: None, From Bottom, From Left, From Right 

and From Top
• Center Mark Length: Enter the center mark length value.

Once the template information is completed, clicking the OK button
will bring the Save ATM Template dialog where you can enter the
name and the location of the .tpl file to be produced.

Layout validation
checkpoints

inpO2 will try to export as many common objects between inpO2 and
ATM but the validation of the layout may detect errors. A check-
points dialogue will be displayed to inform the user about items to
correct. 
• Red X icon: This icon indicates an error. You cannot continue 

unless corrections are made.
• Yellow triangle icon: This icon indicates a warning. It brings the 

attention to an item, but it may not hinder the export from 
working properly.

.
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Table of inpO2-ATM
objects matching

Refer to the tables below to ascertain objects and variable compati-
bilities and relationship.

inpO2 variable Apogee variable
Web index $WEB

Composite ink list $COLOR
Job Identifier $JOBID 
Project name $JOBNAME

Assembly name $JOB_TITLE
Sheet side $SIDE

Booklet index $SIG
Output time $TIME
Output day $DATE

Booklet name discarded
Output month discarded

Output year discarded
Press run name discarded
Sheet number discarded

Template name discarded
Total number of sheets discarded

N/A $COMMENT
N/A $CUSTOMER
N/A $JOBID

inpO2 Comments for conversion 

Plate Unsupported in Apogee. Will generate a check point
error.

Gripper Will be ignored. For best results: set gripper size to
0.

Mirrors Converted to work styles. Editable in the signature
properties. For best results: favor the use of work-
styles instead of mirrors.

- Work & Turn: Design only a half sheet on the
inpO2 layout, the other empty half will be added
automatically.

Page group - Different page formats in a page group will gener-
ate a check point warning.

Fold marks - Fold marks are exported with default length only.

Page
and

Page marks

- Bleed marks are unsupported and discarded. For
best results: disable the bleed marks on the light
table, the layout will be closer to the generated
template.

- Page adjustments are ignored.
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Density bar Converted to exposure bar. For best results: use
additional trim to add an offset to this mark.

Text mark - All unsupported variables will be discarded (see
table below).

- Only text and position is exported (no font).

For best results: use left alignment for the text in
the box so the layout will be closer to the generated
template.

Collating mark Will export section ID according to parent page
(useful for multi-section using multiple collating
marks).

Register mark Will reference .eps files in marks folder at usual
location. For best results: use 18 X 18 pt size.

Linear mark Exported as a solid rectangle.

Imported mark Will expect .eps files and images at the usual loca-
tion and folder. For best results: do not rename the
imported mark image.
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3 inpO2 Marks
All standard marks are available in inpO2. Should there be a need to
add marks that are not available, the Imported Mark object can be
used.

All marks can be defined and saved using Presets (see section 2.5:
“Presets”). They can also be edited on the light table using Object
Properties palette (see section 2.3: “Object Properties Palette”).
Please refer to these sections for general information about the cre-
ation of presets and edition of objects on the light table. 

All marks are dynamic in their size and position, so they can be used
in Mark Sets (see section 3.8.1: “Dynamic Marks”). 

Note also that when register, fold or center marks, are overlapping
page objects, they are clipped to give precedence to the page con-
tents and to prevent output errors that would interrupt automation
tasks.

3.1 Imported Mark
An imported mark may be a color bar, a density bar, a logo or any
other image in PDF format. 

Images are defined once and can be used in every job without having
to be adjusted every time. The source image file is actually embed-
ded in the Imported Marks library for future use (see section 3.1.2:
“Imported Image Presets”).

3.1.1 Imported Mark Presets

The Imported Mark Presets window allows defining the size and
behavior of the box that will hold the PDF image.

The Imported Mark Presets window is available from the inpO2 > Pre-
sets > Imported Mark menu or through the Imported Mark contextual
menu in the Objects toolbar (small arrow near the object’s icon). 
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Contents Here are the properties that are available for an Imported Mark in
the Preset window:
• Image allows to select an imported image from the drop list or to 

access the Imported Image Presets window where you can edit the 
list of available images. To access the Imported Image Presets 
window, click the “...” button at the right of the drop list (see 
section 3.1.2: “Imported Image Presets”). 

• Placement & Usage: This drop menu defines the usage of the 
image on the layout. It creates a frame (crop box) where the PDF 
image will be placed. 
- Use Image Size will use a crop box equal to the actual image 

size.
- Crop and Repeat to Specified Size will create a crop box equal to 

the size specified in the Width and Height fields below. If the 
crop box is larger than the image, the image will be repeated to 
fill it. If the crop box is smaller than the image, the image will 
be cropped.

- Crop and Repeat in Gutter will create a crop box that will snap 
and adapt to the gutter when the mark is placed on the layout. 
It will fill the chosen gutter with the imported mark by repeat-
ing or cropping the image to fit. The image (for example the 
color bar) will be repeated in the orientation of the gutter and 
will cover the extent of the page group.

- Crop & Repeat in Sheet is a dynamic way to place, crop and 
repeat the mark according to the following properties (see also 
next diagram):
> Offset from edge: distance to the nearest edge to where the 

mark was dropped;
> Left/Bottom Offset: distance to apply between the left or bot-

tom end of the mark and the nearest sheet edge. 
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> Right/Top Offset: distance to apply between the right or top 
end of the mark and the nearest sheet edge.

- Apply Work Style on Back: When in perfecting workstyle, the 
color bar on the back can follow or not the same flip axis as the 
sheet in order to comply with various press requirements. For 
example, a color bar placed at the top, on the front of the 
sheet, can either be flipped at the bottom or remain at the top, 
on the back of the sheet. 

• Image Alignment options define how the PDF image will be placed 
in the mark crop box when it is cropped or repeated. 
- The drop menu with the nine anchor buttons is used to align 

the image within the mark crop box. Some color bars with a 
center target must be centered, some others must be left 
aligned. The center anchor point is selected by default. 

- An Horizontal and Vertical Offset can be given to adjust the 
image within the box.

3.1.2 Imported Image Presets

The Imported Image Presets can only be accessed from the Imported
Mark Presets window, by clicking on the “...” button at the right of
the Image drop list (see section 3.1.1: “Imported Mark Presets”). 

This is where PDF files may be embedded as imported images for all
future inpO2 projects. 
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The right-hand side of the window shows a preview of the selected
image as well as a grid of properties.

Document Information • Document Information: This section gives information about the 
PDF source file.
- Document Title: the pdf document’s title property.
- Creator shows the originating application as identified in the 

PDF file.
- PDF version
- The size of all the PDF boxes found in the file is displayed to 

ease the Image Clipping. 

Image Clipping • Image Clipping: A drop list allows for the selection of a PDF box 
for the image usage. The box that is selected will used as the 
default clipping source for the image. The preview will reflect the 
image area that will be used. 
The following box types can be selected: Art Box, Bleed Box, Crop 
Box, Media Box or Trim Box. 

Inks • Inks shows the list of inks detected in the PDF file.

Create and Save the Imported Image as any other Preset. The saved
images will appear in the Image drop list in the Imported Mark win-
dow.

3.2 Text Mark

Text marks are used to identify plates and sheets. Any text or any
variable from the list may be inserted. The variables will be replaced
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by values upon output and values can be displayed on the light
table if selected in the current Profile (see section 2.4: “Profiles”).

3.2.1 Text Mark Presets 

The Text Mark Presets window is available from the inpO2 > Presets >
Text Mark menu, or through the Text Mark contextual menu in the
Objects toolbar (small arrow near the object’s icon). 

The following properties can be defined.

Contents • Text Expression: This field allows to select a predefined text 
expression from the drop list or to access the Text Expression 
Presets window where you can edit them. To access the Text 
Expression Presets window, click the “...” button at the right of 
the drop list (see section 3.2.2: “Text Expression Presets”). 

• Sample: This field displays the selected Text Expression.

Placement & Usage • Single Sided: If the option is selected, the text mark will be 
applied on one sheet side only.

• Apply WorkStyle on Back: Text mark may follow or not the work 
style (turning axis of the sheet) for double-side positioning, to 
comply with various perfecting press requirements. 

Text Box • Text Box Alignment: Aligns the text within its text box. Nine 
positions are available. 
- Width and Height: These fields are used to set up the size of the 

box that will contain the text on the layout.
- Scale text to fit: If this option is selected, it will automatically 

scale down the text to fit the text box. It will never enlarge the 
text.

Format • Format: The following parameters are used to format the text of 
the mark. 
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- Font: Three systems fonts can be selected: Courier, Helvetica, 
and Times-Roman. The font used for text marks can be embed-
ded or not at output (see section 9.2.1: “PDF Output Options”).

- Character Size: Type the font size or use the spinbox control to 
change the value.

- Bold: Check to use bold type.
- Italic: Check to use italic type.

3.2.2 Text Expression Presets

The Text Expression Presets can only be accessed from the Text Mark
Presets window, by clicking on the “...” button at the right of the
Text Expression drop list (see section 3.2.1: “Text Mark Presets”). 

Text Expression are used to create different lines of text containing
variables or free text.

The dialogue has two panels. 

• The Contents section is a text area that can be updated at will. It 
contains plain text and variables that will be replaced by their 
values at output. Plain text is displayed in black and variables are 
displayed in blue. 

• The Variables section is the list of all available variables. To add a 
variable to a text mark, choose the variable from the list and click 
the Arrow icon. The variable will be inserted at the cursor position 
or added at the end of the text if the cursor was not previously 
inserted.

inpO2 offers variables (see following table) for text marks and out-
put. The values of certain variables can be seen on the light table by
selecting Values in the Profiles Presets dialogue (see section 2.4:
“Profiles”). All variable values are refreshed at output time.
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Module name abbreviations: LE =  Layout Editor, O = Optimization,
A = Assembly, J = JDF

inpO2 Modules 

Variable Description LE LE + O LE+A+O+J

Assembly Name Displays the name of the Assembly node, as 
defined in the Assembly Manager. 

X

Booklet Index Displays the rank of the booklet in the Assem-
bly. 
When booklets are inserted into others, indexes 
increment from the root booklet to its child 
booklets, then from the next root booklet to its 
child, and so on.
The index resets for subsequent assemblies.

X

Booklet Name Displays the name of the Booklet node, as 
defined in the Assembly Manager (the default is 
the template name).
The value will display “Multiple” instead of the 
booklet name if the text mark is placed on a 
plate with multiple booklets. 

X

Composite ink 
list (not avail-
able in barcodes)

Displays the name of all the inks found in the 
plate. Each ink is listed one after the other in 
the text mark.

X X X

Imposition Index 
(available in bar-
codes only)

When attached to a page, displays its imposi-
tion index.

X X X

Job Identifier Displays the Job Identifier as defined in inpO2 > 
Set Job Identifiers menu.

X X X

Output day Displays the output day with two digits. X X X

Output month Displays the output month with one or two dig-
its.

X X X

Output time (not 
available in bar-
codes)

Displays the output time with six digits for 
hour, minutes and seconds, separated by dots 
(example 22.45.40).

X X X

Output year Displays the output year with four digits. X X X

Press Run Name Displays the name of the Press Run node, as 
defined in the Layout Manager. 

X X

Product Part 
Name (available 
in barcodes only)

Displays the name of the Product Part node, as 
defined in the Layout Manager. 

X X

Project Name Displays the name of the project (inpO2 file 
name).

X X X

Sheet Number Displays the rank of the sheet in the project. X X X

Sheet side Displays the sheet surface (Front or Back). X X X

Template Name Displays the name of the template used in the 
Assembly Manager.

X

Total Number of 
Sheets

Displays the total number of the sheet in the 
project. Can be used in combination with the 
Sheet Number variable.

X X X
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3.3 Barcode
inpO2 supports different barcode standards for integration with dig-
ital presses and post-press equipments. Supported standards include
the 2/5 interleaved, Code128, and Code 39. 

Barcodes can be attached to sheets, signatures or pages. Their for-
mula can be defined using a combination of variables and character
padding. inpO2 barcodes can be used for various workflow require-
ments. 

When linked to sheets, barcodes can be used as plate IDs. With digi-
tal presses, they can trigger settings for in-line finishing equip-
ments. 

When attached to pages,  can identify product parts in job ganging. 

When attached to signatures, barcodes can also be used for quality
control by post-press equipments. When gathering the book or mag-
azine, an optical reader scans the booklets to automatically detect
missing or misplaced signatures in the publication. 

inpO2 barcodes can be saved with their own presets catalog and can
also be used within mark sets on the light table or with the Layout
Manager.

The barcode variables will be replaced by values (vertical bars) upon
output. These values can be displayed or not on the light table
depending on the current Profile (see section 2.4: “Profiles”).

3.3.1 Barcode Presets 

The Barcode Presets window is available from the inpO2 > Presets >
Barcode menu, or through the Barcode contextual menu in the
Objects toolbar (small arrow near the object’s icon). 

Web Index Displays the rank of the web in its List of Webs 
node.
The value will display “Multiple” if the text 
mark is placed on a plate with multiple sec-
tions. 

X

inpO2 Modules 

Variable Description LE LE + O LE+A+O+J
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The following properties can be defined.

Contents • Encoding Type: This menu offers a selection of barcode formats to 
suit various requirements. These formats include:
- Code 128A: Alphanumeric encoding type that includes ASCII 

characters 00 to 95 (0-9, A-Z and control codes) and special 
characters.

- Code 128B: Alphanumeric encoding type that includes ASCII 
characters 32 to 127 (0-9, A-Z, a-z) and special characters.

- Code 128C: Encoding type that only includes characters 00-99 
(encodes each two digits with one code). Each variable used 
with this encoding type must be limited to an even number of 
digits. If free text is present in used formula, it must also con-
tain an even number of characters to be valid.

- Code 39: Alphanumeric encoding type that supports 26 upper-
case letters, 10 digits and 7 special characters (-, ., SP, *, $, /, + 
and %)

- 2/5 Interleaved: Numeric only encoding type. 
- AsirCode on base code 128C: Used for Müller Martini postpress 

equipments.
- AsirCode on base code 2/5 Interleaved: Used for Müller Mar-

tini postpress equipments.
• Formula: This field allows to select a predefined formula from the 

drop list or to access the Barcode Formula Presets window where 
you can edit them. To access the Barcode Formula Presets window, 
click the “...” button at the right of the drop list (see section 
3.3.2: “Barcode Formula Presets”). 

• Sample: This field displays the selected Barcode Formula.

Placement and Usage • Attached to: Barcodes can be attached to different imposition 
objects. When placing the barcode on the light table, the drop 
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areas of the selected object will be enabled and the barcode will 
snap to them. There are nine possible drop areas.
- Plate/Sheet: If attached to a plate or a sheet, the barcode will 

snap to the border of the plate or the sheet. This type of bar-
code can identify jobs and plate numbers for the pressroom. It 
can also trigger settings for in-line finishing equipments. 

- All Pages: If attached to all pages, the barcode will snap to the 
same drop areas on all the pages of the page group at once. This 
type of barcode can identify product parts or documents when 
ganging jobs for digital printing.

- Single page: If attached to a single page, the barcode will snap 
to the drop areas on the page and will be linked to the page’s 
folding index. This type of barcode can identify booklets for sig-
nature recognition by post-press equipements such as stitchers.

The position of the barcode can be further adjusted using the follow-
ing placement parameters. Note that the labels adapt to the object
that is selected in the Attached to drop menu.
• Offset from edge: A minimal offset should be given to ensure that 

the barcode doesn’t overlap the object to which it is attached.
• Offset along edge: The value of this offset adds up to the blank 

space of the quiet zone.
• Scanner start point: This setting identify the reading direction of 

the barcode by the scanner.

Format • Height of the bars: The height of the barcode can be set with a 
fixed value. 

• Thickness of the narrowest bar: A value is given to the narrowest 
bar. Wider bars will adjust accordingly. The total width of the 
barcode depends on the formula. 

• Quiet zone: A white opaque space can be created before the first 
bar and after the last bar to ensure adequate reading of the 
scanner.
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• Human readable: If this option is selected, the barcode will 
display corresponding letters or numbers, with the Courier 
monospace font, to facilitate the reading. The text is added under 
the barcode without affecting its height (the overall mark size 
will be bigger). This field is enabled or not depending on the 
encoding type.

• Include check digit: Check digit can be put in the barcode for 
formula validation, if required. This field is enabled or not 
depending on the encoding type. If the field is enabled, the check 
digit is allowed. 

3.3.2 Barcode Formula Presets

The Barcode Formula Presets can only be accessed from the Barcode
Presets window, by clicking on the “...” button at the right of the
Barcode Formula drop list (see section 3.3.1: “Barcode Presets”). 

The Barcode Formula Presets are used to create barcode contents
using a combination of variables and/or free text.

The dialogue contains three panels. 
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Contents The Contents section is a text area that can be updated at will. It
contains plain text and variables that will be replaced by their val-
ues at output. Plain text is displayed in black and variables are dis-
played in blue. 

Variables The Variables section is the list of all available variables. 

To add a variable to a barcode formula, choose the variable from the
list and click the Arrow icon. The variable will be inserted at the cur-
sor position or added at the end of the text if the cursor was not
previously inserted.

inpO2 barcode formulas use the same variables as the text marks and
output file names (see section 3.2.2: “Text Expression Presets”). 

The values of certain variables can be seen on the light table pro-
vided that they are activated in the current Profile (see section 2.4:
“Profiles”). All variable values are refreshed at output time.

Variable Properties Each variable used in the barcode formula will be listed in this sec-
tion. 

These variables can be adapted by setting a fixed number of digits
(characters). If no limit is set, the needed number of character is
used. If required, the value will be padded with zeros in order to
respect the fixed number of characters.

If the same variable is used more than one time in the formula, only
one instance will be listed. The same properties will be applied to all
instances of this variable in the barcode.

3.4 Collating Mark

Collating Marks are thumb indexes that identify the first page of
each successive booklet for the post-press assembly (see “Collating
Mark“ in the glossary). Collating marks should always be placed in
the spine gutter so they are visible when the booklets are stacked.

The first individual mark is printed at the top-most position of the
page. For each subsequent booklet, the mark is placed below the pre-
vious one. When the lowest position is reached, the pattern starts
again. 
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Note A Collating Mark is always associated with a specific page in a lay-
out. Therefore, it is impossible to add a Collating Mark unless there is
at least one page in the layout. 

The Collating Mark Presets window is available from the inpO2 > Pre-
sets > Collating Mark menu, or through the Collating Mark contextual
menu in the Objects toolbar (small arrow near the object’s icon). 

A Collating Mark gathers several cells that will be spread among
booklets during the assembly. 

Its characteristics can be defined with a Pattern, a Cell format, and a
Manual Index (optional). 

Pattern The Pattern defines the overall appearance of the mark.

• Cell Range is where the number of cells in the Collating Mark is 
defined. Two options are available:
- Maximum: When chosen, the number of cells will automatically 

be set to the maximum, without going over the height of the 
page it is attached to.

- Fixed: When selected, the number of cells in the mark will be 
determined by the value entered in next field. 

Collating Marks
on 6 sections
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• Number of Cells: Enter the number of cells required for the mark. 
This property must be set manually if Fixed Cell Range is chosen. 
Ensure that the total length will not exceed the page height.

• Cell Spacing: This field allows the user to enter the size of the 
space between the cells.

• Display Header: A header is a filled cell that indicates the top of 
the Collating Mark. This field allows the user to choose to display 
a header or not. 

• Display Outline: Allows the user to choose to display other cell 
outlines. When this options is used, only indexed cells will be 
displayed.

Cell The Cell group of properties defines the characteristics of each indi-
vidual cell. 
• Length and Width of the cell.
• Text Direction: This drop menu allows for selecting the direction of 

the index number. 
- Horizontal
- Upward
- Downward

Manual Index Indexes are automatically incremented from the Assembly Manager
depending on the configuration of the booklets. During the assem-
bly, a Collating Mark cell will be created for each Perfect Bound book-
let (stacked booklets found at the root of the Assembly Tree). No
mark will be created on booklets that are inserted in a Saddle-
stitched manner.

However, the Manual Index group of properties can be used to define
a custom index value for the collating mark. 

Cell Outline

Cell Spacing

Header

Index Value

Cell Width

Cell Length

Cell Range



3 inpO2 Marks — Register Mark • 71

Release: November 20, 2012

• Manual Value: If selected, the value will be static and can be 
edited manually once the Collating Mark is placed on the light 
table.

• Index Value: This fields allows to enter a static value in the cell.
• Index Position: This field forces the manual index to display at a 

specific position in the Cell Range. 

3.5 Register Mark
Register marks are used to align color-separated overlays or for any
other alignment purposes. inpO2 offers different styles of register
marks, all offered in circle or square versions: Empty, Filled, Out-
lined.

Register Marks can be added individually on the layout but groups
can also be configured to ease their positoning on the sheet.

3.5.1 Register Mark Presets 

The Register Mark Presets window is accessible from the inpO2 > Pre-
sets > Register Mark menu or through the Presets contextual menu in
the Objects toolbar (small arrow near the object’s icon).

The following parameters can be edited.

Shape The Shape group of options defines the central part of the mark.
• The Style drop-menu allows selecting the desired appearance of 

the mark. The options are shown in the illustration below.
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• The Radius is half the diameter value of the circle or the square 
portion of the mark. 

• The Thickness is the weight of the line that will form the circle or 
the square shape.

Cross The Cross group of options allow defining the properties of the cross
portion of the mark.
• Height is the total height of the cross.
• Width is the total width of the cross.
• The Thickness is the weight of the two lines that will form the 

cross.

3.5.2 Register Mark Group Presets

It is often easier to apply a group of register marks rather than try-
ing to insert them one at a time and aligning them. Applying a
group of Register Marks is done by accessing the Register Mark’s drop
menu in the inpO2 Objects toolbar and selecting Apply Group on the
current sheet.

Pattern The Register Mark Group Presets window opens to let the user choose
the Pattern of register marks that he/she wants.
• Register Mark: This field lets the user choose an existing Register 

Mark Preset from a drop list. It also gives access to the Register 
Mark Presets window by clicking on the “...” icon at the right of 
the drop list.

Empty
Circle

Empty 
Square

Filled 
Circle

Filled 
Square

Outlined 
Circle

Outlined 
Square
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• Configuration: This field offers a number of pre-defined 
configurations from a drop list. It is also possible to customize the 
configuration by expanding the node in the dialogue and 
selecting each mark individually. The available configurations are:
- Only corner marks
- Only center marks
- All marks

• Offset: This field allows to offset the position of the mark, from 
the edge toward the center of the sheet. If all four offsets are to 
be of the same value, it is only necessary to enter it once in the 
Offset field. If some offsets are to be of a different value, the node 
can be expanded to have access to the four edges.

Click OK to apply the Register mark group on the current sheet.

Important When adding a Register Mark Group, any other Register Mark on the
sheet will be deleted.

The Clear all Register Mark option from the Register Mark drop menu
automatically deletes all Register Mark from the current sheet.
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3.6 Density Bar
The Density Bar Presets window is accessible from the inpO2 > Presets
> Density Bar menu or through the Presets contextual menu in the
Objects toolbar (small arrow near the object’s icon). 

A Density Bar may be positioned in any gutter or margin, as long as
it is wide enough to contain it. If the gutter or margin selected can-
not contain the object, the bar will snap to the nearest valid gutter.

Box and Size The Density Bar properties are as follows:
• The Bar Type drop menu allows to choose the behaviour of the bar 

when snapped to the gutter or margin.
- Full Length: The density bar will cover the full length of the 

page group.
.

- Page Trim: The density bar still covers the whole length of the 
page group, but it is trimmed at the crossing of the gutters. 
This prevents the overlapping of fold marks.

.

• Square Size: This value is used to set the size of the squares color 
cells that form the density bar. Since cells are square-shaped, 
only one value needs to be entered.
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• The Additional Trim property allows the user to add more trim at 
the crossing of the gutters. The type Page Trim must first be 
selected to access this field. 

.

Important The density bar adapts to the color environment of the project.
Please note that the density bar will not display any color unless a
PDF document is loaded (page or imported mark). The proper profile
selection must also be made.

3.7 Linear Mark
inpO2 allows creating any kind of linear mark or of linear bar
directly within the application. These marks are adaptable and can
be used for different purposes, such as: 
• using two marks together and create crossmarks.
• using a very thick mark to create an “ink eater.”

The Linear Mark Presets window is accessible from the inpO2 > Pre-
sets > Linear Mark menu or through the Presets contextual menu in
the Objects toolbar (small arrow near the object’s icon).

Size and Orientation There are only three fields that need to be configured for the Linear
marks:
• Orientation is used to set an initial Horizontal or Vertical shape to 

the line. 
• Length and Thickness values must be entered. The line weight can 

be thickened to create a square.
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Note that the rotation and the scaling can be changed on the light
table using the Position and Size portion of the Object Properties win-
dow. 

3.8 Mark Sets

When a user needs the same marks on a regular basis, it is possible
to define Mark Sets so all these marks can be added at once by
selecting the predefined set.

Mark Sets are dynamically positioned on any sheet according to the
rules used at their creation. 

They can be defined for specific presses, binding types, or color
environments. 

Mark Sets can be used directly from the Layout Manager to ease the
layout creation process (see section 5.3.2: “Step and Repeat Tool”).

When saving a Mark Set, the properties, parent, anchor points and
offset values of all individual marks are recorded as dynamic infor-
mation or rules. The same attributes and rules are applied when
placing the Mark Set on subsequent layouts. 

3.8.1 Dynamic Marks 

inpO2 marks are dynamic in two ways: positioning and sizing. When
marks are used within a Mark Set, the Mark Set inherits of the same
dynamic properties.

Each individual mark has its own characteristics that are reused in
the context of a Mark Set. 
• Marks have customized properties.
• Marks have natural parent objects on which they may snap and 

resize, such as gutters, margins, or pages. Whenever a mark’s 
parent attributes have changed, the mark is updated. 

• Marks can have offset values to adjust them from their natural 
position.

• Marks and their parents have nine anchor points that can be used 
for precise positioning. 

The dynamic behaviour of the marks is the following, when used in a
Mark Set.
• Page Marks and Sheet Marks: Their position dynamically adapts 

to the new page and sheet formats.
• Imported Mark: The Imported Mark can be placed in a sheet, 

gutter or margin. When placed in a gutter or a margin, its 
behaviour will be identical to the behaviour of the Density Bar 
(see below).
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• Text Mark: The position of the Text Mark is relative to the nine 
anchor points of the plate or the sheet and it can be placed 
horizontally or vertically. Its behaviour is identical to the 
behaviour of the Linear Mark (see above), except that the surface 
of the sheet, front or back, is recorded. 

• Barcode: It is placed dynamically inside a the appropriate drop 
zone depending on its parent (Plate/Sheet, All Pages or Single 
Page). When attached to a plate or a sheet, the surface, front or 
back, is recorded. When attached to pages, the folding index is 
recorded.

• Collating Mark: It is placed dynamically on the spine side of the 
page that has the lowest page index on the sheet. The Collating 
Mark length is automatically adjusted to its parent page. 
Whenever a page size is modified, the Collating Mark will be 
updated.

• Register Mark (individual): Its behaviour is identical to the 
behaviour of the Linear Mark (see below).

• Register Mark Group: It is placed dynamically based on its 
configuration and distance from the edge of the sheet. It can not 
be placed on a plate.

• Density Bar: It is placed dynamically inside a gutter (top, 
bottom, left or right) or inside a margin (any vertical or 
horizontal margin). If the bar was placed inside a center margin 
when created, this center will be recorded for the Mark Set. 
Otherwise, the index of the gutter will be recorded (1st gutter, 
2nd gutter, etc.). The size of the Density Bar is also automatically 
adjusted to the page group length and structure. 

.
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• Linear Mark: It is placed dynamically using the vertical and 
horizontal distance from the anchor point selected on the mark to 
the anchor point selected on the sheet or plate. When a mark is 
moved on a sheet or a plate the dynamic mark information (offset 
and position) is updated after the drag and drop operation is 
completed (see figure below).

.

3.8.2 Mark Sets Dialogue

To open the Mark Sets window, click on the Mark Sets icon in the
inpO2 Tools toolbar.

The Default set is always available and can not be removed. This set
contains only sheet and page marks. Use this set with caution as it
may override the sheet and page marks already defined. 

Some other items are installed with the application. Those can be
deleted. 

The Mark Sets dialogue has the same way of saving items and creat-
ing new items as other Presets dialogues (see section : “Tooltips dis-
play when the mouse cursor is positioned over a field for about one
second.”). However, unlike other objects, the dialogue has no edit-
able property grid as mark sets are directly created and modified on
the light table.

Creating a Mark Set • To create a Mark Set, simply add the marks that you require on 
the light table. 

• Take time to position on the layout all the marks that you want 
to be part of the set. The proper anchor points should be selected 
to ensure their accurate positioning on all future layouts. 
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• Click on the Mark Set icon in the inpO2 tool bar. Select the menu 
item Save mark Set as New Preset. The new mark set will be added 
to the elements lists of the Marks set dialogue, indicating the 
quantity and type of the marks of the set.

.

Applying a Mark Set You can select a mark set item and apply it to a press run to build
the complete layout at once (see section 5.3.3: “Planning a Bound
Job”). 

If you work on a layout on the light table, you can apply a Mark Set
as follows: 
• Ensure that the sheet on which you want to apply the mark set is 

active.
• Open the Mark Sets window.
• Select a mark set in the list and click OK. If the layout contained 

other marks before applying the mark set, they will be removed 
automatically. 

• When a particular mark set cannot be used with the current 
layout a red X shows on the bottom right of the window. You can 
expand the node to get more details. 

Note: when working on the light table (and not within the Layout
Manager), if the marks that were defined for the Page Group or for
the Sheet conflict with those defined in the selected Mark Set, a Cus-
tom item will be created to combine all marks. This new Custom item
will be displayed when you click on the Mark Set icon of the toolbar.
From this menu you can choose to save the mark set as a new preset.
If an item already exists that combines identical marks, it will be
selected automatically.
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4 Template 
Assembly

4.1 About inpO2 Assemblies
The Assembly Tree can contain several assemblies displayed in tree-
view, in order to separate job parts that will print differently (for
example the book cover and its content), or to group two different
publications in the same project. The Assembly Tree is highly visual:
simply drag and drop templates inside or below other projects to cre-
ate bindings. Once completed, the imposition may still be modified,
either on the light table or by reopening the Assembly Manager.

Pagination is computed by the Assembly Manager based on the fold-
ing identified in the templates, and incremented as templates are
added to the assembly. For each assembly, creep compensations set-
tings can be applied, and pagination can be configured. 
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Important The Assembly Manager uses templates previously saved on disk (see
section 1.1.4: “File Types”). The Assembly Manager is not available in
Layout mode. To create a new assembly project, select Create inpO2 >
Assembly Project from Acrobat’s File menu.

4.2 The Assembly Manager 
dialogue
To open the Assembly Manager dialogue, choose Show/Hide > Assem-
bly Manager from inpO2’s menu or click on the Assembly Manager
icon from inpO2’s Functions toolbar. 

The Assembly Manager window behaves as a palette and can remain
opened while working on the light table or when using other func-
tions. All changes applied in the Assembly Manager window are
immediately reflected in the layout. 

To close the Assembly Manager, use the x button in the upper-right
corner of the window, uncheck the item in the Show/Hide menu or
toggle the Assembly Manager tool icon.
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The upper part of the Assembly Manager displays information about
loaded templates, such as the template properties or a preview of its
layout.

The lower part is the Assembly Tree. This is where the publication
takes shape. Simply drag and drop templates from the list into the
Assembly Tree. When clicking on any item of the tree, its properties
will be displayed in the right-hand side contextual panel.

As working on the assemblies, the light table will update to reflect
the modifications in real time. Once satisfied with the project, close
the Assembly Manager window. 

4.2.1 Assembly vs Layout

The Assembly Manager can still be reopened to modify the assembly
or to apply minor changes to the layout. However, there are restric-
tions to the modifications that can be applied to the resulting lay-
out once the assembly is created. Controls for the following changes
are disabled in the interface:
• Number of sheets (sheet insertion using inpO2 > Insert Sheet)
• Flip axis (edition of sheet properties)
• Number of pages (creation of new page groups, edition of page 

group properties)
• Number of rows or columns in page group (edition of page group 

properties)
• Foldings or pagination (edition of page group properties, 

Pagination Tool)
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However, you can use the Export inpO2 > Layout function available
from the File menu to flatten the assembly project (.ably) and save
it as a workable layout (.layt). 

Any creep compensation of an assembly can be retained or discarded
in the resulting layout, which can be freely edited on the light table
for custom pagination or other fine tuning.

The layout obtained can also be resaved as a multisheet template
(.tmpl) to be loaded within the Assembly Manager as a building
block for complex multiweb projects.

Important When exporting as a layout a project containing many assemblies,
the pagination will be modified as the run lists will be merged into a
single one. 

4.2.2 Templates

Templates are used as building blocks to create assemblies. They are
layouts that have previously been saved as inpO2 templates. They
can contain as many sheets as required.

From the Assembly Manager, click on the Load button to import the
templates needed to build a publication. 

Important Once templates are loaded in the Assembly Manager, they are embed-
ded in the project and disconnected from the original template file.
Any changes made to the template file will not be reflected on the
assembly project.
Templates are protected and can not be opened using the usual File
> Open menu. To edit a template, select Create inpO2 > Layout from
Template in Acrobat’s File menu, edit the layout and use the Export
inpO2 Template menu item. Once the template is saved on disk,
reload it in the Assembly Manager.

Properties Mode Once a template is loaded in the Assembly Manager, it can be pre-
viewed, or view its basic information by clicking on its name in the
Sheet Templates list. Template Properties will be displayed in the
right panel.

- Number of Sheets
- Number of Pages
- Plate Size
- Sheet Size
- Page Size
- Work Style

If the properties are different within the same template (for exam-
ple, two different sheet formats), the corresponding field will be left
blank indicating there are multiple values.
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Preview Mode To switch to preview mode, choose Preview in the drop-down list
above template information.

If the selected template has more than one sheet, select the one to
preview from the Sheet drop-down list.

The preview always shows the complete page information no matter
what the active profile is.

4.2.3 Assembly Tree

inpO2 displays the publication’s assembly in a convenient, easy-to-
understand tree. 
• Icons help identifying parts of the imposition:

- Assemblies are represented by closed books.
- Booklets are represented as opened booklets.
- Pages ranges are represented as piles of loose pages.
- Single pages are represented as individual pages.

• Node icons are available:
- Lists of webs are represented by rolls of paper.
- Section stacks are represented by scissors.

Assembly

Booklet

Page Range

Page
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- Webs or web sections are represented by sheets.

• Use the drop menu below the tree to show or hide node types in 
the tree (see section 4.3.4: “Tree Display Options”). 

• Each node can be opened or closed by clicking on the triangle 
next to its icon.
- A down-pointing triangle is an open node.
- A right-pointing triangle is a closed node.

• Booklets assembled in perfect-bound style are represented one 
above the other in the same vertical alignment (simulating 
stacked booklets), while those in saddle-stitch style are 
represented as inside one another with indentation (simulating 
inserted booklets).

• Below is a perfect-bound assembly example. Booklets are 
assembled one after the other.

• Below is a saddle-stitch assembly example. Two booklets are 
assembled one inside the other, then another set of two booklets 
is added.

List of Webs

Section Stack

Web

Section

Assembly

First Booklet

Second booklet (perfect bound)

Third booklet (perfect bound)
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4.2.4 Node Properties

The Assembly Tree contains different types of nodes with parent-
child relationship: Assembly node, Booklet node, Page Range node,
and Page node. Each node type has its own icon in the tree. 

Once selected in the tree, each node type displays different proper-
ties and settings to be configured in the contextual panel on the
right side of the window. 

Assembly Node Clicking on an Assembly node displays the whole assembly’s proper-
ties, content and creep settings in the contextual side panel.

• The Properties section contains the assembly’s Name, Notes and 
Target Number of Pages. 
- The Name can be customized to identify different job parts. The 

node will be renamed accordingly in the Assembly Tree.
- In the Target Number of Pages field, enter the number of pages 

in the assembly. This information is used to compute missing 
pages when using the Insert dialogue (see section 4.3.5: “Insert 
Wizard”). This field is also found in the Document Manager.

Assembly

First booklet

First booklet page range

Second booklet (saddle-stitch)

Second booklet page range

Third booklet (perfect bound)

Third booklet page range

Fourth booklet (saddle-stitch)

Fourth booklet page range
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- The Come and Go option transforms the entire assembly into 
Come and Go paginated booklets for binding optimization (see 
section 4.4.4: “Come and Go”).

• The Content section summarizes the content of the assembly: 
number of booklets, sheets, inserted pages and missing pages.

• The Creep section is where you define creep for the Assembly (see 
section 4.5: “Creep Compensation”).

Booklet Node Clicking on a Booklet node displays its Properties and Pagination set-
tings in the contextual side panel.

• The Properties section displays information about the booklet: 
- Booklet’s name (the template name is used by default but it can 

be customized), 
- Number of sheets
- Page size
- Page range
- Number of pages

• The Single Sided menu allows transforming a booklet into a Work 
and Turn or Work and Tumble. 

Important When removing the Work and Turn conversion, all changes made to
the sheet (adjustments, marks, etc) will be lost.

• You can quickly change the number of webs in the selected 
booklet (see section 4.4.5: “Multi-Web”).

• The Stack section allows to quickly change the number of sections 
in the selected booklet (see section 4.4.7: “Use of Sections”).

• The Pagination section is used to determine whether to continue 
pagination from the previous booklet or start at a specific 
number.



4 Template Assembly — The Assembly Manager dialogue • 89

Release: November 20, 2012

Web Node Clicking on a Web node displays its properties in the contextual side
panel:
• The Properties section displays information about the web: 

- Number of sheets
- Page size
- Page range
- Number of pages

• The Partial Web section includes advanced options to modify the 
type of web: 
- The Type drop menu offers different types of partial webs.
- If a partial web is selected in the Type menu, its positioning can 

be selected in the Location menu (see section 4.4.6: “Partial 
Web”).

Section Node Clicking on a Section node displays its properties in the contextual
side panel:
• The Properties section displays information about the section: 

- Number of sheets
- Page size
- Page range
- Number of pages (see section 4.4.7: “Use of Sections”)
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Page Range Node Clicking on a Page Range node displays its properties in the contex-
tual side panel:

- Name of the parent Assembly node,
- Name of the parent Booklet node,
- Number of sheets
- Name of the template
- Page size
- Number of pages

Page Node Clicking on a Page node displays its properties in the contextual side
panel:

- Imposition index
- Page size
- Sheet 
- Creep Compensation value 
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4.3 Working with the 
Assembly Tree

4.3.1 Adding an Assembly

To add an assembly to the Assembly Tree, simply click the Add
Assembly button at the bottom-left of the Assembly Manager win-
dow. This will add a new assembly node at the end of the tree. The
new assembly can then be dragged into its appropriate position.

To remove an Assembly, select the node and click on the Remove but-
ton below the Assembly Tree. 

At least one Assembly must remain in the Assembly Tree.
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4.3.2 Inserting and Removing Templates

Once templates are loaded in the Sheet Templates list in the upper
part of the Assembly Manager, they can be dragged in the Assembly
Tree.

To do so, select the template in the list and simply drag it where you
want it to be in the tree. When the mouse gets to the Assembly Tree,
a horizontal line will appear showing where the template will be
dropped (see section 4.3.3: “Drag & Drop”).

After a template is placed as a Booklet node, it can still be moved,
even to another assembly in the tree.

To remove a Booklet, select the node and click on the Remove button
below the Assembly Tree. 

Several templates may also be inserted at once based on a number of
templates or a number of pages using the Insert Template in Assem-
bly dialogue (see section 4.3.5: “Insert Wizard”).

4.3.3 Drag & Drop

Any single node in the Assembly Tree can be moved using the drag
and drop function. When a node is moved, all his child nodes are
moved as well.
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To do so, simply click and hold on a node, then move it to its new
position and release the click. inpO2 will place the node in its new
location.

When ready to drop the node into a new position, a horizontal line
will appear showing where the object will be dropped.

• To insert the node above another, drag to the upper part of the 
icon.

• To insert the node inside another, drag to the name of the object.

• To insert the node below another, drag to the lower part of the 
icon.

4.3.4 Tree Display Options

Use the drop menu below the tree to activate or not the display of
different types of nodes in the tree. 

It is possible to toggle between these view modes depending on your
needs.

• Show Booklets Only helps to get a clear view of the binding 
structure. 

• Show Page Ranges is useful to obtain more details on the 
assembly, for example the creep compensation value for one 
specific page. 

More menu items are available:
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• Show Webs and Sections displays web configurations and gives 
access to advanced options in the corresponding right panel.

• Show All displays webs, sections, as well as page ranges

4.3.5 Insert Wizard 

Rather than dragging and dropping templates to build the assembly,
several templates can be inserted at once based on a number of tem-
plates or a number of pages using the Insert assistant.

The assistant is accessible by clicking on the Insert button below the
Assembly Tree. 

To activate the Insert button, ensure that the template to be
inserted is selected in the Sheet Template list and a location for the
insertion is selected in the Assembly Tree. The selection must be an
Assembly node or a Booklet node. 

The assistant can thus be used many times within the same assembly
project.

Simple/Advanced
Dialogues

The default insert dialogue covers simple assembly situations.

You can choose to work with the “advanced” dialogue via inpO2 Pref-
erences (see section 1.3.2: “inpO2 Preferences Dialogue”). The
advanced dialogue uses more panels and fields to gather informa-
tion.

First Panel The first Insert panel displays the selected template name and the
selected tree node. 
• The Template Name drop menu lists all templates that are loaded 

in the project. Another template may still be selected from the 
drop menu. 
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• The Insert Location drop menu suggests Inside Tree Selection by 
default. If a Booklet node was selected for the insertion in the 
Assembly Tree, two other options are available for the insertion: 
After Tree Selection and Before Tree Selection. 

When settings are done, click on Next to advance to the next step.

Second Panel The second Binding panel allows you to select basic binding options
for the assembly. 
• The Style drop menu offers three items: 

- Multi-Web to fold many complete sheets together (see section 
4.4.5: “Multi-Web”). This option further allows for partial web 
(see section 4.4.6: “Partial Web”) edition in the assembly tree.

- Section Stacking to cut and assemble sheet sections (sections 
must be found on the selected template) (see section 4.4.7: 
“Use of Sections”).

- Single-Web for normal single web assemblies.
• The Binding drop menu offers two items: 

- Perfect Bound for stacked booklets.
- Saddle-Stitched for inserted booklets.

• Target Number of Pages is the number of pages that are targeted 
for the assembly. This field reflects the value found in the 
Properties panel of the Assembly node, if already entered. It is 
possible to override this value. 

When settings are done, click on Next to advance to the next step.
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Third Panel The third panel varies according to the Style that was selected in the
second panel.

If the Single-Web type of job was selected, the Assembly Content part
offers only one option:
• The Number of Booklets field indicates the total number of 

booklets that you wish to create in the assembly. 

If the Multi-Web type of job was selected (see section 4.4.5: “Multi-
Web”), the Assembly Content part offers these two options:
• The Number of Booklets field indicates the total number of 

booklets that you wish to create in the assembly.
• The Number of Webs indicate how many sheets will be folded 

together to form booklets. Notice that booklets can be further 
edited later in the Assembly Tree.
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If the Section Stacking type of job was selected (see section 4.4.7:
“Use of Sections”), the Assembly Content part offers these three
options:
• The Number of Booklets field indicates the total number of 

booklets that you wish to create in the assembly. 
• Repeat Sections is the number of time the template and all its 

sections will be copied.
• Sections in template indicates the number of sections found in the 

selected template. This field is for your information only and can 
not be edited.

The Single Sided option allows for convenient automatic Work and
Turn or Work and Tumble. The Insert Location for the booklet can
also be selected. Notice that special templates can also be used for
this purpose. The Single Sided option is not available for Section
Stacking.

The Layout Content is a summary of the assembly and indicates:
• The number of Pages Inserted in the assembly.
• The number of Pages Missing based on the target (negative 

numbers indicate that too many pages were inserted).
• The total number of Sheets in the assembly.

To apply changes, click OK. To close without inserting templates,
click Cancel.
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4.4 Bindings
Any number of assemblies may be created in the Assembly Manager.
Creating new assemblies is useful to create different bindings or to
apply different creep settings for parts of a publication.

Bindings are configured visually by dragging templates in the
Assembly Tree (see section 4.3.2: “Inserting and Removing Tem-
plates”). 
• To create perfect bound bindings, simply drag templates one 

below the other.
• To create saddle-stitched bindings, simply drag a template inside 

an existing booklet.
• It is also possible to create combinations of bindings, for example 

32-page saddle-stitched booklets assembled in perfect bound.

4.4.1 Perfect Bound

Here is an example of a perfect bound assembly:

Perfect Bound
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4.4.2 Saddle Stitched

Here is an example of a saddle stitched assembly:

4.4.3 Combinations

Here is an example for a magazine composed of 2 assemblies: 
• The first one (MyMagazine) if the main part of the magazine and 

contains booklets of 32 pages. Each booklet is composed of 2 
saddle-stitched templates. 

• The second assembly (Special Section) is a single 16-page booklet. 

Using two assemblies allows entering different creep settings, differ-
ent run lists and separate page numbers.

Saddle-stitched
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4.4.4 Come and Go

The Come and Go pagination algorithm allows for the binding of two
publications at the time (see “Come and Go“ in the glossary).

Come and Go can be used in combination with Perfect Bound,
Saddle-stitched and multi-web binding styles, provided that the ini-
tial template was correctly paginated with lower page numbers and
higher page numbers on different rows of the page group.

Typical template

Come and Go

9 16 13 12

8 1 4 5

11

48
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Applying Come and Go To apply the Come and Go pagination to an assembly, simply select
the Assembly Node in the tree and check the Come and Go box in the
right panel. 

The number of booklets will be doubled in the Assembly Tree and
split in two halves: the first half will contain lower page numbers
and the second half will contain higher page numbers. Each booklet
will contain half of the pages. The overall pagination will be cor-
rectly incremented in the tree, from top to bottom throughout the
booklets.

Note: To better fit the layout with the number of pages in the publi-
cation, the last booklet can be adapted so that both halves contain
the same pages, thus reducing the run length for these plates. To do
this, use the option Restart Pagination of the booklet right panel for
the second half. The pagination of subsequent booklets will be cor-
rectly incremented in the tree.

Using Collating Marks When applying Come and Go to a Perfect-bound publication, two Col-
lating marks should be applied on the same template. The algorithm
will increment the indexes of the marks to respect the correct assem-
bly of the printed booklets (see section 3.3: “Barcode”).
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4.4.5 Multi-Web

Basics Automatic multi-web pagination can be created from the Insert wiz-
ard (see section 4.3.5: “Insert Wizard”) or directly within the Assem-
bly Tree. 

Multi-web paginations can be used with web presses or sheet-fed
presses (see “Multi-web“ in the glossary).

Multi-web publications may be built by paginating the webs manu-
ally on the light table and saving them as multi-sheet templates.
Once imported in the Assembly Manager, multi-web templates can be
assembled as Perfect Bound or Saddle Stitched bindings. The page
numbers will be incremented according to the pattern set on the
multi-sheet template.

Applying Multi-web When working with multi-web jobs, ensure to select Show Webs and
Sections in the drop menu below the Assembly Tree (see section
4.3.4: “Tree Display Options”).

The use of the wizard (see section 4.3.5: “Insert Wizard”) is recom-
mended for symmetrical multi-web assemblies such as double-web
jobs, or to initiate the creation of more complex assemblies that will
be edited later in the Assembly Tree. 

To assemble a multi-web job within the Assembly Tree, a single sheet
template can be dragged and dropped in the tree as usual. To trans-
form the single-web booklet into multi-web booklet, select the book-

using 2 Collating Marks 
Come & Go publication

1

96

Double-web pagination

9 8 11 6

16 1 14 3
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let that was just created, enter the number of webs in the right
panel and click to apply the change. The added webs will show under
the node List of Webs and the pagination will be reflected on the
light table.

Other booklets can be added in the same manner by inserting tem-
plates and editing their number of webs.

Partial web options (see section 4.4.6: “Partial Web”) and sections
(see section 4.4.7: “Use of Sections”) are also available for more com-
plex jobs.

4.4.6 Partial Web

Basics Partial web paginations can be used to fit the number of pages in the
publication on a narrower paper roll (see “Partial Web“ in the glos-
sary).

inpO2 transforms a full web template into a partial web in a single
click of the mouse. The plate size remains the same as the full web

Full-web

Half web (operator side)

7 18

15 10

6 19

22 3

13 12

24 1
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but only some of the pages will be used and paginated to fit on the
partial web. 

Any number of partial webs with any location can be defined in the
same booklet.

No section needs to be defined on the template.

Applying Partial Web When working with multi-web jobs, ensure to select Show Webs and
Sections in the drop menu below the Assembly Tree (see section
4.3.4: “Tree Display Options”).

In the Assembly Tree, select the Web node to be transformed into a
partial web. 

In the right panel, two options must be defined:
• The Type menu offers Full Web, 1/2 web, 1/4 web or 3/4 web. If 

the template can be divided into three parts, the menu will offer 
1/3 web and 2/3 web.

• If a partial web is selected in the Type menu, Gear Side (left) or 
Operator Side (right) must be chosen from the Position menu to 
indicate the positioning of the narrow web on the press.

When settings are applied, the partial web will show under the list of
webs node and the pagination will be reflected on the light table.
Notice that no marks or bars will remain on the unused side of the
plate.

4.4.7 Use of Sections

Basics Press sheets can be cut into sections before the assembly. Sections
can be used for Split-web (see “Split Web“ in the glossary) or sheet-
fed presses where printed sheets are cut and stacked before folding.
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To assemble sections within the Assembly Tree, templates must pre-
viously be created with different section letters A, B, etc. (see sec-
tion 2.2.3: “Sheet Sections”).

Section stacking can be created from the Wizard (see section 4.3.5:
“Insert Wizard”) or directly within the Assembly Tree. 

Working with Sections When working with sections, ensure to select Show Webs and Sec-
tions in the drop menu below the Assembly Tree (see section 4.3.4:
“Tree Display Options”).

A single sheet or multiple sheet template containing sections can be
dragged and dropped in the tree as usual in a Perfect Bound or Sad-
dle-stitched manner. 

A Section Stack node with a scissor icon will be created that will con-
tain all Section nodes. The Assembly Manager will automatically pag-
inate the stack of sections based on the number of sections found in
the single sheet or multiple sheet template. 

To multiply the number of sections in the booklet, select the booklet
node that was just created, and enter the number of times the sec-
tions will be repeated in the booklet right panel. Click to apply the
change. The added sections will show under the Section Stack node
and the pagination will be reflected on the light table. 

Typical templateSection Stack

5A 4A 5B 4B

8A 1A 8B 1B

9A 8A

11B 6B

16A 1A 14B 3B


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Other booklets can be added in the same manner by inserting tem-
plates and editing their number of sections.

Once the assembly is created, Section nodes can be rearranged by
drag and drop within the same Section Stack node.

Limitation All sections of the same template must be used within the same
booklet.

4.5 Creep Compensation

4.5.1 About Creep

In inpO2, creep (see “Creep“ in the glossary) is configured at assem-
bly level. You can create multiple assemblies for parts of your publi-
cation that will use a thicker media, hence need special creep
compensation settings. 

On the layout, an arrow shows the direction of the creep compensa-
tion and the number in the arrow indicates the amount of creep that
will be applied to that page. The display of the creep information on
the layout is defined in the Profiles (see section 2.4: “Profiles”).

Creep adjustment can be done on page trim or page content accord-
ing to user preference (see section 1.3.2: “inpO2 Preferences Dia-
logue”). When creep adjustment is applied on page trim, the page
marks “move” on the sheet to indicate the new page trim position.
When applied to page content, the marks stay aligned with the reg-
ular page group structure. 

Creep compensation can be done by pushing in inner pages or by
pushing out outer pages of the booklet. A combination of push in
and push out is also possible.

BothPush outPush in

Paper

Position after creep compensation
Original image position
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To set creep values, click on an Assembly node and choose what type
of creep configuration is required, then enter the values.

Compensation Range values can be specified or enter the Paper Thick-
ness and let inpO2 do the rest. Both methods are synchronized: as
values are changed in one method, those of the second will adjust.

The two methods are explained in the following sections.

4.5.2 Compensation Range Method

Compensation Range tells inpO2 the adjustment values to be applied
to the thickest booklet in the assembly. If all booklets do not have
the same number of pages, the creep compensation for smaller book-
lets will be adjusted automatically.

In a simple Saddle Stitched binding assembly, the Compensation
Range adjustment value must be set for the whole publication. 

In a simple Perfect Bound binding assembly, the Compensation Range
adjustment value must be set for a single booklet. 

Basic adjustments Two fields are available:

• In the Inner Pages field, enter a negative value so that pages on 
the inside of the booklet move towards the spine, away from the 
edge. When using the Inner Pages field, the Outer Pages field may 
be set to zero to obtain a one-direction adjustment (push in).

• For Outer Pages field, enter a positive value so that pages on the 
outside of the booklet move towards the edge, away from the 
spine. When using the Outer Pages field, the Inner Pages field may 
be set to zero to obtain a one-direction adjustment (push out).

• To obtain a half and half adjustment of push-in and push-out, 
enter half of the total adjustment value in both fields. The Inner 
Pages value must be negative while the Outer Pages value should 
be positive.

Advanced adjustments Using the compensation range values, inpO2 will distribute the creep
settings based on the biggest booklet in your assembly, and adjust
for the smaller booklets. 

To move all pages in the same direction, one of the values usually
needs to be set to zero.
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Here is an example of an assembly with booklets of different config-
urations and a compensation range defined as Inner Pages: -0.15 in
and Outer Pages: 0 in.

To move pages in two opposite directions, the Inner Pages value
must be negative while the Outer Pages value should be positive.

Here is an example of an assembly with booklets of different config-
urations and a compensation range defined as Inner Pages: -0.3 in
and Outer Pages: 0.3 in.

Third booklet, pages 65 to 80

-0.0409 in

-0.0545 in -0.109 in

-0.0409 in -0.0955 in -0.15 in

First booklet, pages 1 to 16

Second booklet, pages 17 to 64

Compensation range: 0.15 in

-0.109 in-0.0545 in

0 in

0 in

0 in

0 in

-0.0409 in

0 in

0 in



4 Template Assembly — Creep Compensation • 109

Release: November 20, 2012

Despite the natural way of setting values, both values can be posi-
tive and both values can be negative. The result is that all pages will
first be shifted equally by a certain amount inward or outward
before the progressive creep compensation is applied.

Here is an example of an assembly with booklets of different config-
urations and a compensation range defined as Inner Pages: -0.5 in
and Outer Pages: -0.1 in.

Third booklet, pages 65 to 80

0.136 in

0.0818 in -0.136 in

0.136 in -0.0818 in -0.3 in

First booklet, pages 1 to 16

Second booklet, pages 17 to 64

Compensation range: 0.6 in

-0.136 in0.0818 in

0.3 in

0.3 in

0.3 in

0.3 in

0.136 in

0.3 in

0.3 in
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4.5.3 Paper Thickness Method

When specifying a paper thickness, inpO2 will calculate the creep
compensation to apply to each page. 

You can choose to apply the creep in 3 different ways:
• Push In applies the creep by moving the pages towards the inside 

of the booklet.
• Push Out applies the creep by moving the pages towards the 

outside of the booklet.
• Both Directions applies the creep evenly, moving the outer pages 

of the booklet towards the edge and the inner pages towards the 
spine.

Third booklet, pages 65 to 80

-0.209 in

-0.245 in -0.391 in

-0.209 in -0.355 in -0.5 in

First booklet, pages 1 to 16

Second booklet, pages 17 to 64

All pages are shifted by -0.1 in

-0.391 in-0.245 in

-0.1 in

-0.1 in

-0.1 in

-0.1 in

-0.209 in

-0.1 in

-0.1 in

Compensation range: 0.4 in
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Push In Push Out Both

Pages will be moved towards the spine,
with the most adjustment to the inner
pages of the booklet.

Pages will be moved towards the edge, with
the most adjustment to the outer pages of
the booklet.

Pages on the inside of will be moved to-
wards the spine, pages on the outside will
be moved towards the edge.
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5 The Layout 
Manager
The Layout Manager tackles the layout imposition challenge with a
particular concern for the product’s and equipment’s specifications.
Once it has gathered adequate knowledge, mostly by the user’s pre-
paring the necessary presets, it becomes the powerful and flexible
tool at your hand to realize assemblies and gangings in a very
straightforward manner.

The Layout Manager panel handles two main inpO2 tasks:
• Optimized Job Ganging (often named Optimization Module),
• Planning for Bound Jobs (often named Assembly Planner Module).

This chapter describes how to set up presets and how to use the Lay-
out Manager.

5.1 Presetting Materials and 
Equipment 
The following equipment and materials should be defined before
using the Layout Manager:
• Page formats (see section 1.6.2: “Page Format Presets”)
• Presses
• Papers
• Finishing Methods

These Presets contain all specifications that are used to automati-
cally build and validate layouts as they are chosen in the Layout
Manager window. 

See section  2.5: “Presets” for general information on how to use
inpO2 Presets. 

5.1.1 Press Presets

Select inpO2 > Presets > Press to open the Press Presets window. 
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Technical specifications for presses are easily available from the
press manufacturer. Do not hesitate to refer to them to create your
Presets. The basic press parameters that will have an impact on the
creation of the layout are:

Press Type These attributes will activate or deactivate other press settings. 

• Perfecting: This press attribute will be used to validate the work 
style used on the layout.
- Never: The press can not tumble sheets to print the back. The 

back of the sheet is always flipped on the vertical axis (sheet-
wise work style).

- Can Perfect: The press can perform perfecting or not depending 
on the job type and number of colors. If it does, the sheet sizes 
may be different due to the mechanism required to tumble the 
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sheet between ink units. If this type is selected, minimum and 
maximum values of Sheet Size in Perfecting Mode must be 
entered (see below).

- Always: The press always tumbles the sheets to print the back.
• Requires Plates: The press uses physical plates (conventional or 

direct imaging presses). 

Plate Size Enter the exact width and height of the plate. If different plate sizes
are possible for the press, create a new press item for each plate for-
mat. These fields are enabled only if the option Requires Plates is
checked. 

Sheet Alignment The press’ specifications or characteristics may require that the
sheet be aligned and offset in a unique way. 
• Sheet Alignment: combine Bottom/Middle/Top vertical values with 

Left/Right/Center horizontal values to set the alignment.
• Horizontal Offset and Vertical Offset: insert the required values.

5.1.2 Printing Stock

These properties relate to the paper usage on the press that is being
defined.
• Gripper Edge: This indicates where the gripper is located on the 

paper. Options are Left, Top, Right and Bottom (usually Bottom). 
• Gripper Size: This indicates the amount of space required on the 

sheet for the gripper to be able to grab it. This area will be 
excluded for positioning layout objects.

• Maximum Paper Thickness: Enter the maximum thickness value for 
the press. This value will be used to validate the selected Paper. 

Minimum and Maximum Sheet Width and Height: Enter the minimum
and maximum sheet formats that can be supported on the press.
These values will be used to validate the selected Paper. 

Sheet Size in Perfecting Mode: Enter the minimum and maximum
sheet formats that can be supported on the press when using it in
perfecting mode. The Can Perfect press type must first be selected to
activate these fields.

5.1.3 Paper Presets

Select inpO2 > Presets > Paper to open the Paper Presets window. 
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Paper Properties The paper properties are as follows:
• Width and Height: Enter the exact width and height of the sheet.
• Grain Orientation: Choose Grain long if the paper grain is parallel 

to the largest paper side (portrait), or Grain short if the paper 
grain is parallel to the smallest paper side (landscape). The grain 
direction is a very important parameter for the creation of the 
layout.

• Paper Thickness: The paper thickness value will be validated 
against the maximum thickness allowed by the press. It will also 
be used for automatic creep compensation in case of bound jobs.

• Description: This optional field can be used to further identify 
stock. It is not used for the layout creation.

5.1.4 Finishing Method Presets

Select inpO2 > Presets > Finishing Method to open the Finishing
Method Presets window. 

Finishing Method presets summarize requirements for different post-
press equipment, such as binders and cutters, that must be taken
into account for correct page positioning and paper margins on the
imposition layout. 

These requirements are also used for validations. 
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The following parameters must be defined. 

Finishing Method
Properties

Finishing Style: This drop menu indicates the type of finishing. It
activates or deactivates other settings in the window. Options are:
• Perfect Bound: Finishing style using perfect binding equipment 
• Saddle Stitched: Finishing style using saddle stitching equipment 
• Ganging: Finishing style using cutters (no binding)

Format Minimum and Maximum Formats: These fields determine the width
and height of the minimum and maximum formats supported by the
finishing equipment. This data is used for Checkpoint validations. 

Trimmed Paper Trimmed Paper: Depending on the Finishing Style selected, the fields
will display Left/Spine, Right/Face, Top/Head and Bottom/Foot, or
Spine, Face, Head and Foot. Values must be set on the four sides to
create trim distances on the layout. These distances will apply to all
Product Parts. 
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Additional Waste Additional Waste: This section will display only if the Finishing Style
is Perfect Bound or Saddle-stitched. These fields must be set to create
extra margins on the layout.
• Milling Depth: This field is activated for Perfect Bound style only. 

The Milling Depth is the depth that is required for spine cutting or 
notching for before gluing. It will add extra margin at the spine 
on the layout. This value must be set according to the equipment 
capabilities. 

• Overfold Size: This field is activated for Saddle-stitched style only. 
It defines the margin value required to create a lap on the booklet 
to ease its positioning on the saddle. This value must be set 
according to the stitching equipment specifications. 

• Overfold Side: This field indicates whether the lap will be on the 
left (low folio lap) or on the right (high folio lap) on the folded 
booklet. This value increases the corresponding gutters or 
margins on the layout. 
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• Top and Bottom Cuts: These optional fields can be used to allow 
for additional top and bottom paper margins for cutting.

5.2 The Layout Manager 
dialogue
To start a new project using the Layout Manager, select File > Create
inpO2 > Managed Layout. This opens the Layout Manager window.

The Layout Manager is divided into 3 sections.

A) The Press Runs section at the left is a tree-view interface used to
build the project (see section 5.2.1: “Press Runs Tree Structure”).

B) The upper-right section is a contextual panel that displays prop-
erties of the node that is selected in the Press Runs tree (see section
5.2.2: “Properties”).

Left Overfold (or lap)

1
1

Right Overfold (or lap)

A

B

C
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C) The lower-right section is reserved for Checkpoints that gather all
errors and warnings detected on the layout during its creation (see
section 5.2.3: “Checkpoints”). 

5.2.1 Press Runs Tree Structure

The Press Runs panel on the left side of the Layout Manager is used
to build the project structure. 

It contains a toolbar that give access to the main functions:
• Add a new Press Run for job ganging 
• Add a new Press Run for bound job
• Add a Product Part 
• Load a pdf document file
• Remember tree selection (Press Run or Product Part) as default
• Delete the tree selection 

A project may contain any number of Press Runs. 

The Layout Manager allows for the creation of imposition layouts
from source documents. An empty layout can also be created with-
out documents. Documents can be added subsequently.

New Managed Layout
from Documents

If document files are available, it is suggested to use them to ease
the process. When using documents, the following information will
be extracted from the pdf file to initiate the layout: 
• Trim box
• Bleed box
• Number of pages

To create a new Press Run from a document, click on the Load Docu-
ment icon and browse, or drag and drop the document from its folder
into the Run Lists section of the dialogue. It is possible to drag and
drop many documents at once.

A Press Run node and one or many Product Part nodes will be added
into the tree. inpO2 will suggest the project structure that is the
most appropriate for the type of document, based on the number of
documents and the number of pages detected.

New Managed Layout
without Documents

The layout can be constructed without documents by manually add-
ing a Press Run node, then one or many Product Parts inside the
Press Run node. 

There are two types of Press Run nodes, one for Ganging and one for
Bound works, each type having a slightly different set of parameters. 
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To create a new Press Run for a ganging, click on the Press Run
(Ganging) icon. A node will be added in the tree. 

To create a new Press Run for a bound job, click on the Press Run
(Bound) icon. A node will be added in the tree. 

To create a new Product Part, select the Press Run in the tree and
click on the Product Part icon to insert it. The Product Part will take
different attributes whether it is inserted in a Ganging or in a Bound
Press Run.

Many Press Run nodes are possible in the project.

Adding Documents Documents can be subsequently added in different ways into the
empty layout. 
• By selecting a Press Run node in the tree and using the Load 

Document icon. Documents will create populated Product Parts in 
the selected Press Run and these new Product Parts will be 
identified with the document names. The document informations 
will also be detected to create the layout.

• By selecting a pre-defined Product Part node in tree and using the 
Load Document icon. Documents will populate the selected 
Product Part without renaming it or changing page format.

• By using the Document Manager, as usual, from the main inpO2 
toolbar. Product Parts must be defined first. The Document 
Manager will display the project structure as constructed in the 
Layout Manager (see section 8.1.1: “About inpO2 Run Lists”). 

Other Actions
within the Tree

Other actions can be done within the tree.

Nodes can be dragged and dropped in the tree to rearrange the proj-
ect structure. Product Parts can be moved within the same Press Run
or into a different Press Run. 

Moving a Product Part within the same Press Run changes its priority
rank and is very useful for job ganging (see section 5.3: “Using the
Layout Manager”).

To create default settings, select a node in the tree and click on the
Remember as default button. You can set defaults for Ganging and
Bound Press Runs, and for Product Parts. 

A selected node can be deleted by clicking on the Delete tool icon.
When deleting a Press Run, all associated Product Parts will be
deleted as well. 

It is possible to Undo any operation using habitual menu or shortcut.

5.2.2 Properties 

When selecting a node in the tree, the upper-right panel displays
Properties that must be edited to manage the layout, and Statistics
that give important data about the project. 
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Properties and Statistics will adapt to the node that is selected in the
tree. 

Press Run (Bound) When selecting a Press Run (Bound) node, the upper-right panel dis-
plays the following Properties. 

• Name: This optional text field can be used to enter a descriptive 
name for the press run. The name will be shown in the tree node.

• Description: This optional text field can be used to enter any kind 
of information that would be useful for this project.

• Press: This drop list contains all the presses that have been 
defined in the Press Presets window (see section 5.1.1: “Press 
Presets”). Select the press that will be used for the current press 
run. 
It is possible to access the Press Presets window and define a new 
preset by clicking on the “...” button that appears at the right of 
the drop list when it is selected. 

• Work Style: This drop list contains possible work styles.
- Simplex: Only one side of the sheet is printed.
- Perfecting: The sheet will be tumbled on the horizontal axis to 

print the back.
- Work and Back: The sheet will be flipped on the vertical axis to 

print the back.
• Paper: This drop list contains all the papers that have been 

defined in the Paper Presets window (see section 5.1.3: “Paper 
Presets”). Select the paper that will be used for the current press 
run. 
It is also possible to access the Presets window by clicking on the 
“...” button at the right of the drop list. 
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• Mark Set: This drop list contains all the mark sets that have been 
defined in the Mark Sets window (see section 3.8: “Mark Sets”). 
Select the set that will be used for the current press run.

• Distance Between Edge and Finished Product: This area is a margin 
on the border of the sheet that can be reserved for printing the 
marks. A warning will occur if pages overlap this restricted area. 
The value can be set for all sides at once, if entered in the main 
field, or by expanding the node to have access to the four sides: 
- Left
- Top
- Right
- Bottom

Statistics give important information about the project. 
• Number of Product Parts: Indicates the number of Product Parts 

within the selected Press Run.
• Paper Waste: The percentage of paper waste helps choosing the 

right paper format or layout configuration for the project. 
• Number of Sheets: Indicates how many sheets are needed in the 

current Press Run. 

Press Run (Ganging) When selecting a Press Run (Ganging) node, the upper-right panel
displays the same Properties as the Press Run (Bound) node, plus
additional properties that are specific to flatworks. 

Pre-Finishing Parameters can be set to prepare ganging layouts for
finishing. 
• Minimum Spacing Between Product Groups: This value creates a 

space between different product groups to allow for cutting apart 
sections of the sheet before product finishing.
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• Organize Layout in Rows: If selected, this option will force the 
positioning of the product parts in rows, allowing for automated 
cutting.

• Maximum Number of Rows: The maximum number of rows (cuts) 
supported by the finishing equipement should be entered in this 
field.

• Organize Layout in Columns: If selected, this option will force the 
positioning of the product parts in columns, allowing for 
automated slitting.

• Maximum Number of Columns: The maximum number of columns 
(slits) supported by the finishing equipement should be entered 
in this field.

Requested Product Quantities is a shortcut that can be used to
quickly change multiple product part quantities from the same list.
The values are synchronized with the Requested Quantity values of
each Product Part nodes.

The Statistics area displays one more entry for Ganging Press Runs:
• Run Length: Indicates the run length needed to print requested 

product quantities. Only this statistics field can be edited, to 
recalculate new quantity values for it’s products. 

Product Part (Ganging) When selecting a Product Part node that is placed in a Ganging Press
Run, the upper-right panel displays the following Properties. 

• Name: This optional text field can be used to enter a descriptive 
name for the product part. The name will be shown in the tree 
node.
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• Description: This optional text field can be used to enter any kind 
of information that would be useful for this product part.

• Page Format: This drop list contains all the formats that have 
been defined in the Page Format Presets window (see section 
1.6.2: “Page Format Presets”). Select the format that will be used 
for the current product part. It is also possible to access the Page 
Format Presets window by clicking on the “...” button at the right 
of the drop list. 

• Select the Aspect (portrait or landscape).
• Grain: This drop menu allows for the positioning of the Product 

Part on the paper.
- Parallel: The Product Part will be placed parallel to the grain ori-

entation. A publication parallel to the grain allows for a 
smoother fold than working across the grain. 

- Perpendicular: The Product Part will be placed across the grain 
orientation. 

- Either: If this option is chosen, the application will use either 
direction to optimize the sheet usage.

• Folding: This drop list contains all the foldings that have been 
pre-defined (see section 2.2.2: “Page Group Folding”). If required, 
select the folding that will be used for the current product part. 
Flatworks have a 1x1 folding by default. 
It is possible to access the Presets window by clicking on the “...” 
button at the right of the drop list to preview foldings. 

• Bleed: This field allows entry of a bleed value that will be used on 
all sides of the page. 
Note: The display of the bleed can be restricted by parameters 
defined in the Finishing Method Presets. Adding bleed values does 
not modify the layout creation, it only allows for printing the 
bleed area if there is enough space in the gutters, margins, or 
between product parts. 
If the bleed is different on one or more sides, the Bleed node can 
be expanded to give access to four sides: 
- Left/Spine
- Right/Face
- Top/Head
- Bottom/Foot

• Finishing Method: This drop list contains all the methods that 
have been defined in the Finishing Method Presets window (see 
section 5.1.4: “Finishing Method Presets”). Select the method that 
will be used for the current press run. 
It is also possible to access the Presets window by clicking on the 
“...” button at the right of the drop list. 

• Requested Quantity: This data is important for the optimization of 
the sheet usage, as the quantity of each Product Part is taken into 
account when building the layout. For each Product Part, the 
actual quantity vs. requested quantity is displayed in the tree 
node. The default quantity is 1000. 
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The Layout Arrangement offers options for the placement of the
Product Part in the layout, based on the content of the source docu-
ment.
• Stick to Gripper: If selected, the Product Part will have a priority 

for a placement near the gripper for best printing quality.
• Bleed Merging Side: The left, right, top or bottom side of the 

Product Part can be selected for bleed merging. In this case, the 
step and repeat layout automatically rotates and snaps some 
instances of the Product Part to share the same bleed in order to 
optimize paper usage and number of cuts. 

In the Statistics, only one information is available for Product Parts
(Ganging).
• Actual Quantity: This field indicates the exact number of copies 

that will be printed for the selected Product Part, if using the 
current settings. The application tries to build a layout that will 
respect the quantity requested, but it is not always possible due 
to other Product Part constraints. 

Product Part (Bound) When selecting a Product Part node that is placed in a Press Run for
a Bound work, the upper-right panel displays the following Proper-
ties. 
• Name: This optional text field can be used to enter a descriptive 

name for the product part. The name will be shown in the tree 
node.

• Description: This optional text field can be used to enter any kind 
of information that would be useful for this product part.

• Page Format: This drop list contains all the formats that have 
been defined in the Page Format Presets window (see section 
1.6.2: “Page Format Presets”). Select the format that will be used 
for the current product part. 
Select the Aspect (portrait or landscape).
It is also possible to access the Page Format Presets window by 
clicking on the “...” button at the right of the drop list. 
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• Grain: This drop menu allows for the positioning of the Product 
Part on the paper.
- Parallel: The Product Part will be placed parallel to the grain ori-

entation. A publication parallel to the grain allows for a 
smoother fold than working across the grain. 

- Perpendicular: The Product Part will be placed across the grain 
orientation. 

- Either: If this option is chosen, the application will use either 
direction to optimize the sheet usage.

• Folding: This drop list contains all the foldings that have been 
pre-defined (see section 2.2.2: “Page Group Folding”). Select the 
folding that will be used for the current product part. The folding 
will determine the page group structure, the page orientation, 
and the folding number.
It is possible to access the Presets window by clicking on the “...” 
button at the right of the drop list to preview foldings. 

• Finishing Method: This drop list contains all the methods that 
have been defined in the Finishing Method Presets window (see 
section 5.1.4: “Finishing Method Presets”). Select the method that 
will be used for the current press run. 
It is also possible to access the Presets window by clicking on the 
“...” button at the right of the drop list. 

• Bleed: This field allows entry of a bleed value that will be used on 
all sides of the page. 
Note: The display of the bleed can be restricted by parameters 
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defined in the Finishing Method Presets. Adding bleed values does 
not modify the layout creation, it only allows for printing the 
bleed zone if there is enough space in the gutters, margins, or 
between product parts. 
If the bleed is different on one or more sides, the Bleed node can 
be expanded to give access to four sides: 
- Spine
- Face
- Head
- Foot

The group Assembly Properties contains important settings for the
project assembly.
• Binding Style: The binding style must be selected from this drop 

menu. 
- Perfect Bound: Booklets are stacked one on top of the others.
- Saddle Stitched: Booklets are inserted one inside the others.

• Requested number of pages: Enter the target number of pages for 
the bound Product Part. The value will immediately drive the 
creation of additional sheets to complete the layout.

• Work & Turn: If the project requires a work and turn to fit the 
number of pages, this drop menu allows selecting which sheet will 
be used. 
- None: No work and turn will be created.
- First Sheet: A work and turn will be created on the first sheet.
- Second Last Sheet: A work and turn will be created on the sec-

ond last sheet.
- Last Sheet: A work and turn will be created on the last sheet. 

In the Statistics, the following information is available for Product
Parts (Bound).
• Actual Number of Pages: The actual number of pages created on 

the layout. If the actual number of pages is higher than the 
target number of pages, blank pages will have to be added.

• Booklet Count: The number of booklets required for this product 
part.

5.2.3 Checkpoints

Checkpoints are embedded in the bottom-right section of the Layout
Manager window. 

This unique information provider acts as a preflight tool for the lay-
out creation. Any anomaly that is detected on the layout, for exam-
ple overlapping objects, missing pages in the run list or high
percentage of waste paper, will display an error or warning. 

Checkpoints are a must within the Layout Manager where the opera-
tor experiments different layouts by changing production compo-
nents. While managing a layout, checkpoints guide the user in the
selection of appropriate equipment and materials.
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They are also available as a smaller palette to give the operator more
confidence when working on the light table. This palette can be acti-
vated by the Layout Checkpoints icon in the toolbar.

Note: Checkpoints only check the most important and common mis-
takes that can be done. It does not necessarily guarantee the entire
validity of the project. However, if an attempt to output is made
while checkpoints report errors, a warning message will be displayed
so the user can be aware of possible anomalies in the output. 

Checkpoints are always sorted by severity order in the list.
• Red X icon: This icon indicates an error. The user must resolve the 

issue before finishing the layout project. However, errors are 
indications only and will not prevent the output.

• Yellow triangle icon: This icon indicates a warning. It brings the 
attention to an item, but it may not hinder the layout from 
working properly.

• Green check icon: When the icon is green, the item is normal.

5.3 Using the Layout Manager 

This section gives general steps and recommendations when using
the Layout Manager. The necessary presets should be created first
but it is also possible to experiment using generic presets installed
with the application.

5.3.1 Ganging Optimization 

General Steps The general steps are as follows.

• Create a new managed layout by selecting File > Create inpO2 > 
Managed Layout. 
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• In the Layout Manager window, click on the first tool icon to add 
a Press Run for job ganging.

• Set the Press Run parameters in the upper-right panel. Select 
Presets for the Press, Paper, and Finishing Method that will be 
used. 

• Observe the checkpoints in the lower-right section. The 
compatibility of selected components is validated each time a new 
selection is done. Do not spend too much time adjusting them as 
all these settings may change later. 

• The goal is to obtain the most optimized layout scenario by 
changing production components. Press Run parameters can 
thus be changed later after Product Parts are defined.

• Once the Press Run (Ganging) is defined, you can either load 
documents to create Product Parts, or insert empty Product Parts. 
Either way will produce Product Parts nodes in the Press Run.

• Set the parameters of each Product Parts in the upper-right panel, 
if required. The requested quantity is a very important data for 
the optimization, especially if it is different for each Product Part. 

• As soon as Product Parts are defined, the resulting layout can be 
validated on the light table. 

• At this point, if the checkpoints are still showing errors, it is 
important that they be resolved. Each error and warning item in 
the list can be expanded to see details of the problem. Thus it 
should be relatively easy to figure out a solution.

Tips for Optimization Prepare the work space to have a good preview of the resulting lay-
out. 
• In the inpO2 Profiles dialogue, customize the working profile to 

display Product Part Names as well as Product Part Colors. This will 
help to identify the different Product Parts on the light table.

• Activate the Pages panel on the left side of Acrobat’s window to 
see thumbnails. Thumbnails can also be enlarged from the Options 
menu.

Know these simple rules to achieve the best optimization.
• Enter the largest product first and continue with smaller ones. If 

the sheet is already filled with smaller products, larger products 
will have no place to fit, but if the larger product is placed, 
smaller ones will flow around it to fill remaining spaces.

• When possible, try Product Parts to follow alternate grain 
orientation, or to be placed on either grain orientation to give 
more flexibility for the positioning. 

• A Product Part in the Press Run can be prioritized for a placement 
near the gutter edge for best printing quality. 

• Product Parts can share a bleed side to save cuts and paper.
• When managing too many Product Parts, it may be necessary to 

add another Press Run and distribute the Product Parts among 
Press Runs for a better usage ratio.
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Make a good usage of checkpoints and statistics.

• Don’t worry too much about the checkpoints until all the product 
data has been entered since errors may automatically be resolved 
during the process. When all product intents are entered, use 
different settings to get the best result.

• All errors in the Checkpoints should be eliminated before output. 
All warnings should be looked at.

• Monitor the quantities the layout will produce for each product 
part. They are displayed in the tree with two numbers (such as 
1000/1000) representing Actual Quantity/Requested Quantity. 
inpO2 will always try to enter the exact Requested Quantity or 
more. If the Actual Quantity exceeds what was requested, a 
warning will be displayed in the Checkpoints. If the Actual 
Quantity is lower than what was requested, an error will be 
displayed.

• Monitor the Paper Waste. A waste exceeding 25% of the sheet will 
create an error in the Checkpoints. Do not hesitate to change 
paper size, even for a smaller format, to compare the percentage 
of Paper Waste in the Statistics.

After closing the Layout Manager, the layout can be further edited
on the light table if desired. The Step and Repeat tool is especially
adapted for manual edition of ganged jobs (see section 5.3.2: “Step
and Repeat Tool”).

Also note that although the Layout Manager is closed, the Check-
point feature is still available by clicking on its icon in the Functions
toolbar. 

Managed Layout vs
Layout

You can also use the Export inpO2 > Layout function available from
the File menu to flatten the managed layout project (.mlay) and
save it as a freely workable layout (.layt) on the light table. 

Using this export function, ganging jobs created with the Layout
Manager can be reused on the light table for repeated production.
When exporting as a layout a ganging project, the pagination will be
modified as the run lists will be merged into a single one. 

Any creep compensation of an assembly can be retained or discarded
in the resulting layout, which can be freely edited for custom pagi-
nation or other fine tuning.

Troubleshooting Problem: Not all Product Parts are created. 

Solution: inpO2 is unable to fit all products on the sheet. You can: 

• In the tree, drag and drop Product Parts within the Press Run to 
place the product that has the largest format first in the list. 

• Select a bigger paper format

• Select another grain direction, or select either grain direction.

• Create another Press Run and distribute Product Parts.
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Problem: Product Parts are too close to the paper edge.

Solution: Enter a value in the Distance Between Edge and Finished
Product of the Press Run. Values can be set on the four sides.

Problem: The same Product Part has different grain orientations on
the paper. 

Solution: Instead of Either grain orientation, select Parallel or Per-
pendicular to force the same orientation for all occurrences of the
Product Part. Note that this may result in an increase of the paper
waste.

Problem: The bleed does not appear on the resulting layout. 

Solution: The Finishing Method must allow space for bleed. Ensure
that Trimmed Paper values are set correctly.

Problem: I want to print the same Product Part head to head to
share bleed at the top. 

Solution: Select the Product Part node and set the Bleed Merging
Side to Top in the drop menu. The layout will be automatically
adapted for bleed merging.

Problem: I need extra space between two blocks of Product Parts.

Solution: Simply select the Ganging Press Run node and enter a
value in the field Minimum Spacing Between Product Groups. 

Problem: I have empty areas on the sheet that I want to fill to avoid
paper waste.

Solution: For each Product Part, inpO2 tries to create the exact
requested quantity, or slightly more when the exact quantity is not
mathematically possible. You can fill the empty areas in two ways. 
• Slightly increase the requested quantity of the Product Part near 

the empty zone. Note that this may change significantly the 
configuration of the layout.

• Go to the light table, select the Product Part near the empty zone 
and click on the red arrow to add copies (see section 5.3.2: “Step 
and Repeat Tool”).

5.3.2 Step and Repeat Tool

When ganging many product parts with different quantities, the
optimization will try to respect these quantities and may not be able
to completely fill the sheet. 

In addition to the Layout Manager, inpO2 offers a convenient Step
and Repeat tool to edit managed layouts on the light table.
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Once the layout is created through the Layout Manager, the selec-
tion of a Product Part adjacent to the empty area displays, on the
edge of the Product Part, one or many arrows pointing to the area(s)
to be filled. 
• Click on the arrow to add one copy of the product part. 
• Ctrl-click on the arrow to fill the entire row or column at once.

At this stage, Product Parts can be deleted, moved and added freely
on the light table. 

All Product Parts created from the Layout Manager are available from
the Page Group contextual menu. They can be selected in the menu
and placed on the sheet as you would do for a Page Group Preset. 

The Step & Repeat tool is fully integrated with the Layout Manager
and manual changes are reflected in press run statistics (product
part quantities and wasted paper ratio). 

5.3.3 Planning a Bound Job 

The Layout Manager allows for the creation of paginated product
parts from scratch, based on folding presets and other press and
post-press production requirements (Page Formats, Paper, Presses
and Finishing Methods). 

No initial template is needed. The page trim and bleed are detected
directly from the PDF files or can be set manually. 

Once presets are defined for existing printing equipment, the user
simply selects, for each press run, a combination among production
possibilities based on job specifications and equipment usage. Last-
minute changes can be done quickly to route a job part to another
press, and the layout is automatically recalculated based on alter-
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nate production capabilities. Check Points will warn the user if any
anomaly is found on the layout.

Marks can be added at once using predefined Mark Sets (see section
3.8: “Mark Sets”).

Press runs for bound product parts can be mixed with any number of
other press runs for flatworks in the same managed layout, so the
user can address any production challenge in one single project.

The resulting assemblies are fully integrated with the Assembly Man-
ager, the Document Manager, the Light Table and other inpO2 compo-
nents.

General Steps The steps for the creation of a bound work are similar to the ones for
ganging. Presets must first be defined. 
• Create a new managed layout by selecting File > Create inpO2 > 

Managed Layout. 
• In the Layout Manager window, click on the second tool icon to 

add a Press Run (Bound) that will activate options for the bound 
work.

• Set the Press Run parameters in the upper-right panel. Select 
Presets for the Press, Paper, and Finishing Method that will be 
used. 

• Select a Mark Set.
• Observe the checkpoints in the lower-right section. The 

compatibility of selected components is validated each time a new 
selection is done. 
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• Once the Press Run (Bound) is defined, you can either load a 
document or insert an empty Product Part. Either way will 
produce a Product Part node in the Press Run.

• Set the properties of the Product Part in the upper-right panel. 
- Select the Page Format, or validate the one detected from the 

loaded document. 
- Select the Grain direction
- Carefully choose the Folding to create the correct page group 

structure
- Set or validate the Bleed values.

• Set the properties of the Assembly. 
- Select the Binding Style.
- Enter the Total Number of Pages in the publication
- You may choose a Work & Turn to fit the number of pages.

• The resulting layout with the complete pagination and all marks 
can be validated on the light table. 

Limitations The Layout Manager does not support multiple web assemblies.
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6 Using the 
Wizard
The Wizard serves two purposes:
• The easy creation of layouts and assemblies, ready to edit on the 

light table or to send for output.
• The definition of automated job presets to be used by the 

Automation Manager (see chapter 7).

Working files created from the Wizard (.layt or .ably) are compatible
with other inpO2 modules such as the Document Manager and the
Assembly Manager. These working files can be saved and reused, for
example, by simply changing the Run List1. 

6.1 Creating a layout with the 
Wizard

1. Run lists are used in the Document Manager and may not be available in entry-
level editions.
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To create a file using the Wizard, go to File > Create inpO2... > Use the
Wizard. The Creation Wizard dialog opens.

Throughout the creation process, warning messages may appear at
the bottom of the dialogue if any error is detected. 

The Wizard will keep in memory the parameters of the last project
created.

6.1.1 The Document panel

The Wizard builds projects from one PDF document at the time. If
the project is split in many PDF files, use Acrobat to merge pages
before using the Wizard, or start without a document and add them
later with the Document Manager.

The right section displays information related to the source docu-
ment and finished product.

Source document:
• Start without a source document: when this option is selected, the 

Wizard will create an empty layout without a source document. 
This choice is convenient for exporting the layout file as an inpO2 
template (.tmpl).

• Load a source document: select and click the Browse button to 
choose the file to process. The first page of the source document 
will displayed.

• Name displays the file name of the document (if present).
• Creator displays the application from which the PDF file was 

created.
• Number of Pages indicates the total number of pages found in the 

document.

Finished product:
• Page Width and Height fields display the page format that was 

detected in the source file (if any). It is based on the PDF TrimBox 
or on the PDF MediaBox if no TrimBox is defined. These values can 
be overridden to crop the source file and allow for bleed creation.

If you chose the option Start without a source document you must
enter default values for the page Width and Height. Then you can
continue through the next panels to enter more settings. 

The button Load Preset... is used to load an existing Wizard preset
(previously saved in the finalization panel, see  section 6.1.6). It will
set all the values of the following panels identical to the chosen pre-
set. You can browse and edit these values afterwards.

After validating the information displayed, click Next to move on to
the next step.
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6.1.2 The Project Type panel

The second panel determines the type of the project. The Wizard
offers the following capabilities:
• Perfect Binding
• Saddle Stitching
• Step and Repeat
• N-Up
• Custom Flatwork
• Cut and Stack

Here is a brief explanation for each working style:

Perfect Binding is a binding where the sheets are folded into booklets
and then the booklets are stacked one on top of the others. This
type of binding is mostly used for books or magazines.

Saddle Stitching is a type of binding where the sheets are folded into
booklets and then the booklets are inserted one inside the others. 

This type of binding is mostly used for stapled or stitched booklet
publications.
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With Step and Repeat, the same page is printed many times on the
sheet which is then cut. It may be printed on a single side or on
both sides. The repeat style be set by column, row or page.

It may be used for various flatworks for paper saving.

With N-Up, the pages are not folded, but simply spread on the sheet
and cut to produce different flatwork documents. It may be printed
on a single side or on both sides. 

It may be used for various multiple page flatworks.

Custom Flatwork is used for pages to be cut separately in ganging
layouts containing documents with identical formats. It uses custom
defined imposition patterns and optional repetition.

With Cut & Stack, the pages are not folded, but simply cut in piles
with the lowest number pages in one stack and the highest number
pages in another stack. Then the first stack is put on top of the sec-
ond one, and so on (since many stacks are possible). It may be
printed on a single side or on both sides. 

It may be used for various multiple page flatworks or spiral bound
publications.

Saddle StitchingPerfect Binding

1 1 1 1

1 1 1 1

Step and Repeat (1 side)

1 1 1 1

1 1 1 1

Step and Repeat (2 sides)

2 2 2 2

2 2 2 2

1 2 3 4

5 6 7 8

1 3 5 7

9 11 13 15

N-Up (1 side) N-Up (2 sides)

8 6 4 2

16 14 12 10
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Choose a project type and click on Next to move on to the next
panel.

6.1.3 The Sheet Definition panel

The Sheet Definition panel is where the sheet parameters are defined.

• The Sheet Size section allows entering the following information:
- The Width of the press sheet.
- The Height of the press sheet.

• The Gripper area section allows entering the gripper size value. 
When no gripper is used in the printing process, uncheck the 
Gripper box to disable the use of a gripper. The Wizard will 
automatically set the gripper at the bottom of the sheet.

• The Flip Axis section is used to define the behaviour of the back 
sheet.
- Vertical Axis. The back sheet will be flipped according to a verti-

cal axis. The left side of the sheet would then appear at the 
right on the back.

Cut & Stack

1
9
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- Horizontal axis. The back sheet will be flipped on a horizontal 
axis. The top of the sheet would then appear at the bottom of 
the sheet on the back. 

- None (Single Side Printing). No back sheet will be created on the 
light table.

• If the selected flip axis is not supported with the work style 
selected in the second panel, a warning message will appear at 
the bottom of the dialog.

Click the Next button to move on to the next panel.

6.1.4 The Page Group Definition panel

The Page Group Definition panel presents a preview of the layout so
far configured. inpO2 auto-calculates the maximum number of pages
per sheet based on the parameters previously entered.

• The Folding drop menu presents the Folding Presets list. 
Customized foldings, if any, will also be displayed (see section 
2.2.2: “Page Group Folding”).

• Rotation is used to apply a rotation to the page group. The 
preview pane will be updated to display the new page group 
configuration.

• The Bleed field allows entering the bleed value that will be 
applied to all page sides. 

• Spine, Vertical and Horizontal Gutters: These fields are required to 
create space between the pages. The values will react differently 
depending on the project type. 
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• Page Group Offsets: These adjustments will position precisely the 
page group on the sheet, based on the Center on Sheet or Snap to 
Gripper placement defined in the previous panel.

• Set fixed number of pages: In flatwork types of projects, this 
option will allow to override the maximum number of pages in 
rows and columns suggested by the wizard. 

Click on the Next button to access the next panel.

6.1.5 The Mark Definition panel

The Mark Definition panel is divided into four tabs: Page and Sheet-
Marks, Register Marks, Text Marks and Density Bar.

Most of them give access to marks Presets (see section : “Tooltips dis-
play when the mouse cursor is positioned over a field for about one
second.”). 

If a mark uses an imported pdf image, the inks detected in the pdf
image will automatically be mapped to the document’s inks.

Page and Sheet Marks In the Page and Sheet Marks tab, select the checkboxes of the marks
you want to use.

• The Page Marks section offers the option of using: 
- Trim and Bleed marks
- Mark offset values for each type of mark
- The option All Corner Marks creates page marks in the gutters, 

which can be convenient for flatworks.
• The Sheet Marks section offers the option of using: 
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• Side Guides/Sheet guides including the Image, Distance from 
Bottom and Offset from Edge values. Sheet guides are a variant of 
the side guide mark. They normally are used with digital presses 
and serve as reference marks of specific shapes, often to be 
detected by optical sensors.

• Center marks that will be placed on the border of the sheet at the 
vertical and horizontal centers.

Register Marks The next tab allows for the use and edition of Register Marks. Check
the Use this mark box to add Register Marks on the layout.

The Wizard will placed Register Marks in the four sheet corners.

• Select a Register Mark Preset from the drop list. Clicking on the 
“...” button located to the right of the list gives access to the 
Register Mark Presets dialogue where you can edit Presets.

• It is possible to enter offsets from the sheet corners by entering 
values in the Left, Right, Bottom and Top Offset fields. Positive 
values will offset the marks towards the center of the sheet.

Text Marks The next tab allows for the use and edition of Text Marks. Check the
Use this mark box to add Text Marks on the layout.



6 Using the Wizard — Creating a layout with the Wizard • 145

Release: November 20, 2012

• Select a Text Mark Preset from the drop list. Clicking on the “...” 
button located to the right of the list gives access to the Text 
Mark Presets dialogue where you can edit Presets.

• In the Alignment drop list, select from which anchor point the 
mark will be positioned on the sheet, 

• It is possible to enter Horizontal Offset (X) and Vertical Offset (Y) 
values. Depending on the anchor point that was selected, 
negative values may be required. Positive values move the mark 
right or up. Negative values move the mark left or down.

• Direction: choose one of the four text directions options.

Color Bar The last tab allows for the use and edition of a built-in Density Bar.
or the import of a color bar PDF image. Check the Use this mark box
to add Color Bar on the layout.

For the built-in Density Bar:
• Select a Density Bar Preset from the drop list. Clicking on the “...” 

button located to the right of the list gives access to the Density 
Bar Presets dialogue where you can edit Presets (see section 3.6: 
“Density Bar”).

• Choose its position from the drop menu: Top, Bottom, Left, Right, 
Horizontal or Vertical Central Gutter.

• If you have selected Top, Bottom, Left, Right position, enter an 
offset from the page edge.

If you import an External Image:
• Select an Imported Image Preset from the drop list. Clicking on 

the “...” button located to the right of the list gives access to the 
Imported Image dialogue where you can edit Presets (see section 
3.1.2: “Imported Image Presets”).

• Choose its position from the drop menu: Top, Bottom, Left, Right, 
Horizontal or Vertical Central Gutter.
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• If you have selected Top, Bottom, Left, Right position, enter an 
offset from the sheet edge.

Click on Next to move on to the last panel.

6.1.6 The Finalization Panel

The Finalization panel summarizes the main parameters of the layout
and offers few more settings to finalize the project. 

The Project Summary section displays the following information:
• The Binding Style
• The Number of Sheets
• The Page Format
• The Document file name of the source document, if any.
• The Number of Pages in the document
• The number of Unused Document Pages, if any. 
• The number of Added Blank pages. Blank pages are automatically 

added if the source file contains less pages than the imposition 
layout.

In case of bound project types, more options are available.
• The Work and Turn drop menu allows for the creation of a half 

booklet at the following position in the assembly: First, Last, or 
Second last. Work & Turn will be applied only if necessary in case a 
preset is reused with different page quantities.

• A Creep Compensation value may also be defined based on the 
Paper Thickness field.
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Check the Open Output Dialog box to immediately output the project
on exiting the Wizard. 

Saving Wizard Settings The Save Settings Button is used for keeping the actual wizard con-
figuration as a preset. The save dialog prompts the user to enter a
name for the preset. Also, for the automation process (see next
chapter), one of the following options must be selected:
• Page size is fixed: the values obtained from the document panel 

will be used for automation. Remember that when actual values 
differ from the fixed values, the fixed page size option may have 
the effect of cropping the page content and putting extra bleed to 
the source document’s original values.

• Page size adjusts to source document: the detected size of the 
source document will be used.

It is possible to browse the previous panels and modify some param-
eters at all times. Once satisfied, click Finish and see the entire lay-
out on the light table. 

Modifications may also be applied to the layout on the light table
before output. 
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7 inpO2 
Automation 

7.1 About inpO2 Automation
inpO2 automation is based on one or many hot folders defined with
the Automation Manager. Each active hot folder is instructed, via a
Wizard preset and an output configuration, on how to process the
imposition job. 

Hot Folders Hot folders are file folders or special files selected to be monitored
and processed by programs. The inpO2 Automation Manager uses
workflows linked to file folders. 

When inpO2 Automation is activated, the automated imposition pro-
cess will be triggered by simply placing a source pdf document in
one of the active hot folders. Many production workflows can be
configured to generate various types of jobs: step & repeat, cut &
stack, saddle-stitched, etc. The page format can be fixed or entirely
adapted to the source document.

The inpO2 Automation module can interact with any production
workflow system using hot folders. 

inpO2 Automation:
Quick Steps

inpO2 Automation users will generally follow these steps:
1 Using the Wizard Interface, define and save an imposition job (see 

chapter 6).
2 Using the Output Configuration dialog, save the output settings, 

taking care to define a destination folder (see section 9.2).
3 Prepare folders (input, archive and error) on a file system accessible 

to the Automation process. 
4 From the Acrobat file menu, select Automate inpO2...
5 In the Workflows panel, click the Create New Item icon
6 Set the Input, Archive and Error folders by browsing the folders set 

in step 3.
7 Select the Wizard Preset as saved in step 1.
8 Select the Output Configuration as saved in step 2.
9 Click the Start button.
10 Place documents in the input folder and expect finished job 

shortly.
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Notice that most of these steps are preliminary to the very first use
of the Automation Manager and need not to be repeated for similar
imposition projects, whence the Automation benefit.

7.2 The Automation Manager 

The Automation Manager enables users to define “hot folders” and
monitor automated tasks. It can be accessed via the Acrobat File
menu File > Automate inpO21. 

The Automation Manager displays a panel with two tabs, Monitoring
and Workflows. At the bottom, three buttons are displayed: Start,
Stop and Close.

Starting and Stopping
the automation process

The Start button will launch the process activating the hot folders
and their monitoring. Validations are first performed to check if the
minimal set of values is populated and usable. At this point, if a
value is missing, a message box will be displayed to inform the user.
When the process is running, this button is greyed out.

The Stop button is active when the automation process runs. It tells
the process to stop all activities, after terminating the current job.

Closing the automation
Manager

The Close button exits the automation Manager, provided no process
is running, otherwise, it is greyed out. 

7.2.1 Automation Workflows

The Workflows tab is where users can define hot folders and config-
ure the process to be performed for each of them. Hot folder work-
flows are displayed like presets, with an items list on the left side of

1. This feature is active only with the inpO2 Automation module.
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the panel and the folder properties to the right (see section 2.5:
“Presets”). 

The workflow items are named after the hot folder name.

The properties of each workflow item are:
• Input folder: this is the file directory to become a hot folder, 

where the incoming pdf files have to be dropped. This field allows 
the user to browse directories and choose a folder. Once the folder 
is selected, the Input folder field will contain the path and the 
name of the folder.

• Archive folder: Once the pdf file is being processed, it is moved to 
the Archive folder. Users select this folder exactly like the Input 
Folder

• Save inpO2 Job Files in Archive: If checked, the project files 
generated by the automation process will be kept in the Archive 
Folder. When unchecked, it tells the process to move only the 
source pdf files to the Archive Folder.

• Error Folder: If, for some reason, the process is interrupted while 
processing a file, the corresponding project file will be saved in 
the Error Folder. A text file (<document name>.txt)containing 
information about the event and the error message will also be 
saved in the same folder. The source files will be moved to the 
Archive Folder to maintain the integrity of the run list in the job 
file.

• Wizard Settings: this field is a drop-down list of the available 
Wizard settings saved in the Wizard’s finalization panel (see 
section 6.1.6: “The Finalization Panel”). Users can manage these 
settings by clicking the “...” button which gives access to the 
Wizard presets dialogue. The wizard setting tells the Automation 
Manager what to do to achieve the project.

• Output Configuration: this field is a drop-down list of the available 
output configuration settings. Users can manage these settings by 
clicking the “...” button which gives access to the output 
configuration presets dialogue. For more details on the output 
configuration, see section 9.1: Main Output Dialogue.
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• Output Folder (from Output Configuration): this read-only field 
reminds the user of the output folder location as set in the Output 
Configuration preset. This field must not be blank.

• Disable this Workflow: When checked, this field removes the folder 
from the automation process without losing its settings. The 
name displayed in the list will be suffixed with “(Disabled)”.

7.2.2 Monitoring Automation

inpO2 users can monitor or record automation activities in the Moni-
toring tab of the Automation Manager. Users can assess the state of
the automation process with the information provided in the follow-
ing fields:
• Actual Status: this field tells the status of the automation process. 

Three straightforward statuses are possible:
- Waiting for a file
- Processing “<file name>.pdf” (from folder “<folder name>”)
- Stopped

• Since: displays the date and time of the last status change.
• Recent Activities: this scrollable text box contains the history of 

the last 100 activities (started, stopped, successful and failed).
• Completed Jobs: statistical field containing the number of 

completed jobs since the last time the dialog was opened.
• Failed jobs: statistical field containing the number of failed jobs 

since the last time the dialog was opened.
• See Failed Jobs: this field allows the user to browse the Error 

Folder, and verify the project files or related error files (*.txt).

Log activities in this file: when checked, this field will activate the
logging of the process activities. The file to update is selected with
the “...” button. It will contain information such as times, duration
and statuses of each processed file.
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7.2.3 Avoiding Disruptions of the Automation Process

Because inpO2 performs numerous validations during the automa-
tion process, disruptions of the automation process are possible.
Many of the disruptions causes are avoidable and most of them are
easy to troubleshoot.

The following list summarizes such possibilities.
• “External” errors. They interrupt the automation process and 

require user intervention:
- Hot folder unreachable: generally related to lost network con-

nection or accidentally renamed or moved folders, etc. 
- Error while moving a pdf file: Incomplete access or read/write 

rights could cause such an error. Insufficient disk space or 
folder changes during the process could also trigger this error.

- Error while saving a job file: The source pdf will be found in the 
Archive folder but the process will have stopped. A message box 
will alert the operator in such case.

- Error while writing log file: This could mean that the log file is 
locked, requires unavailable disk space or that the network con-
nection is faulty.

• “Internal” errors. Such errors are caused by anomalies in the 
source files, incompatibilities between files and job settings or 
other similar conditions. These errors do not interrupt the 
automation process but cause the pdf source files to be moved to 
the error folder along with a text file describing the cause of the 
error.
- Failure of a validation usually done by the wizard: Some valida-

tions that are performed while using the wizard are also per-
formed in automation mode because they are related to the 
source document. Since this file may change, new files may con-
tain error sources.

- Failed checkpoints: Layout checkpoints are validated by the 
automation process. They are categorized as warnings or errors. 
Only errors will lead to an output failure. The messages dis-
played by the checkpoints will be written to the error file and 
will help solve potential errors.

- Validate pdf versions: The version of pdf format used by 
imported images and source documents is checked to match the 
output configuration settings for the maximum supported pdf 
version. In case of conflict, this error is thrown.
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- Output errors: They pertain to all messages related to the execu-
tion of the imposition output, such as problems with output 
directories, destination, etc.
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8 Working With 
Documents 
inpO2 offers an easy way for adding PDF documents to your imposi-
tion.

When the run list is populated with PDF files, it is possible to pre-
view these document pages on the light table, provided that the
Page Contents checkbox is selected in the active profile (see section
2.4: “Profiles”).

8.1 The Document Manager

The Document Manager has two main functions: 
• Build the run list by adding PDF files to the imposition. 
• Adjust document pages to fit with layout pages, if required. 

The Document Manager is available from the inpO2 > Show/Hide
menu, or by the Document Manager icon in the inpO2 Functions tool-
bar. 

The Document Manager window behaves as a palette and can remain
opened while working on the light table or when using other func-
tions. All changes applied in the Document Manager window are
immediately reflected in the layout.

At the left side of the Document Manager window is the Project Tree
that displays a tree structure of the project. The type of node that is
selected in the Project Tree will give access to a contextual panel on
the right side. The three node types are:
• The Run List (one or many)
• The Document (or Page Range) 
• The Page 

8.1.1 About inpO2 Run Lists

Any prepress-ready PDF files can be inserted in inpO2’s run lists.
Once a document is inserted into a run list, the Ink Table and the
layout are automatically updated.

inpO2 creates one run list for each different assembly or job part,
corresponding to the project structure defined in the Assembly Man-
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ager and the Layout Manger. For simple jobs such as jobs created
from the Wizard or on the light table, only one run list is created. 

All you need to do is to browse and load PDF documents to the run
lists. Each run list may contain any number of documents (complete
or partial), blank pages and reservation pages (used in JDF work-
flow).

8.1.2 Project Tree Functions

The left area of the Document Manager is called the Project Tree. It
shows a tree structure of the project run lists.

Selected nodes in the tree will display different data in the right
panel. 

All actions can be done in the Project Tree using the toolbar icons. 

Import Document

Move Up

Insert Blank Page Move Down

Insert Reservation Page

Delete
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Importing Documents
Into the List

To add files to the run list, click on Import Document icon and
browse to the appropriate file. If there are many Product Parts in the
project, first select the Product Part for which you want to insert
document files. 

Multiple files may be selected in the folder using the usual com-
mands. Files will be added in alphanumerical order in the Run List. 

An Import Document Options dialogue will display. Depending on
the job status and selected files, the dialogue may vary.

For the source file you can:
• Select the page range to be used from the imported file (all 

document pages will be set by default),
• Indicate the number of times the pages will be imported,
• Inverse the page order (placing pages from the last to the first in 

the run list),
• Inverse the document order (if multiple document files were 

selected for import).

For the destination you can:
• Set the pagination index to place document pages (a value will be 

suggested),
• Replace existing document pages.

Click OK to import the documents in the tree. 

If the placement is incorrect in the list, select the file and use the
Move Up and Move Down arrows on the toolbar to move the selection. 

You can also drag and drop a node in the tree.

Documents appear in the Run List with numbers in square brackets
representing the page range in the run list, for example [1~3]. 

Deleting a Document To delete a document from the run list, select the document node in
the tree and click on the Delete icon. 

You can delete any node in the list: a document, a page range or a
single page. When a page is deleted, a reservation page is placed as a
placeholder. This reservation page can be deleted if not required.
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Inserting a
Blank Page

Blank pages are meant to be blank when the job is printed (see
“Blank Page“ in the glossary). 

To insert a blank page in the imposition index, select the document
before which the blank page will be inserted and click on the Insert
Blank Page button. If no document is selected from the grid, the
blank page will be added to the end of the active run list.

The blank page will move as documents are added ahead of it in the
imposition index.

You can change the number of blank pages by editing the blank page
count in the right contextual panel.

Inserting a
Reservation Page

Reservation pages are placeholders for missing pages and are meant
to be filled afterwards once documents are available (see “Reserva-
tion“ in the glossary). Reservation pages are mostly used for JDF
output to the RIP as they create the appropriate “missing document”
status in the JDF run list. 

The insertion and edition of reservation pages is identical to the
insertion of blank page (see above for details). 

Document Not Found When reopening an inpO2 project, if the document is not found due
to a file renaming or moving, the document icons in the tree and in
the title bar of the contextual panel will change and the document
will have to be manually relinked. 

8.1.3 Run List Properties

When a run list is selected in the Project Tree, the right panel dis-
plays general information fields describing this run list. 
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• The Total number of pages entered in the Assembly Manager or the 
Layout Planner and any related Notes are displayed and can be 
edited. When making changes to the Total Number of Pages or 
Notes fields in the Document Manager window, the information 
will be updated in the Assembly Manager window and vice versa.

• A reader spread preview is also displayed.

8.1.4 Document Properties

When a document is selected in the Project Tree, the right panel Doc-
ument displays information regarding this document. 

Here is a description of each document property.

Source Source group: This group contains view-only information about the
file. 
• Document Title: Displays the file name of the original source 

document that was used to create the PDF file.
• File Path: Displays the file path of the selected PDF file.

Information Information group: This group contains view-only specific informa-
tion about the PDF. 
• PDF Creator: Displays the name of the technology used for the 

creation of the PDF file. 
• PDF Producer: Displays the name of the application that was used 

to distill the PDF file.
• PDF Version: Displays the number of the PDF version of the 

selected document. This information is used for validation at 
output (see section 9.2.1: “PDF Output Options”).

• Date Modified: Displays the date the file was last modified 
(convenient to verify document versions).

• Trim Box: Displays the size of the PDF pages trim box.
• Page Count: Indicates the total number of pages in the selected 

document.
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Odd and Even Page
Adjustment

Page Adjustment controls (see section 8.1.6: “Page Adjustments”)

Inks Inks: These non editable fields indicate the inks that were found in
the PDF document.

8.1.5 Page Range Properties

When multiple single-page PDF files are inserted at once in the Proj-
ect Tree, a Page Range node is created in the tree. This node is meant
to play the same role as a multi-page Document by gathering many
pages.

The right panel Page Range displays information regarding the
selected collection of pages. 



8 Working With Documents — The Document Manager • 161

Release: November 20, 2012

8.1.6 Page Adjustments 

Page adjustments such as offset, scaling and rotation can be applied
in inpO2 and previewed in real time on the light table.

Adjustments are possible at different levels: on a Document or a Page
Range node, on all odd or even pages of the selected node, or on any
individual Page node. Just click on the desired node to have access
to the page adjustment controls.

Once documents are added in the Document Manager, any page from
the layout can be adjusted. 

Adjusting a Page Range Page adjustments are possible at the Document or Page Range level.
Click on the node in the tree to display the properties in the right
panel.

Page adjustments are controlled separately for odd pages and even
pages. The possible adjustments are as follows.

• Source Box to be aligned: This drop menu allows to choose which 
document page PDF box (ArtBox, BleedBox, CropBox, MediaBox, 
TrimBox) will be used as a reference for the page positioning in 
the layout. 

• Anchor: This drop menu allows for the selection of an anchor 
point that will be used for the adjustment. The default anchor 
point is at the center.

• Horizontal Offset: This field is used to apply a horizontal (X axis) 
offset to the document page within the layout page.

• Vertical Offset: This field is used to apply a vertical (Y axis) offset 
to the document page within the layout page.

• Rotation: This allows changes to the orientation of the page in 
steps of 90º. 

• Scaling: This field allows the user to scale the document page up 
or down to fit with the layout page size. A change in this field 
affects both horizontal and vertical scaling. 
For anamorphic scaling, expand the node to see the following 
fields:
- Horizontal: This field allows the user to scale the page up or 

down horizontally.
- Vertical: This field allows the user to scale the page up or down 

vertically.

• Cancel creep compensation: This checkbox is used to prevent the 
automatic creep adjustment for a specific page (for example a 
spread). When checked: prevents the creep compensation option. 
Automatic creep adjustments are set in the Assembly Manager 
(see section 4.5: “Creep Compensation”).

Adjusting Single Page The Project Tree lists all pages individually. If pages are not seen in
the tree, simply expand the Document or Page Range node.
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Adjustments that are possible at the Page level are similar to adjust-
ments performed at the Document level, but the page can be pre-
viewed to ease the adjustment. 

Important Page adjustments take into account both the document page and the
layout page outline. If you have more pages in the Run List than
there are in the layout, extra pages will be displayed in the Project
Tree, but will be disabled for page adjustments.

8.1.7 Shortcut to documents from the light table

A quick access to the run list is possible from the contextual menu
of a selected page, allowing user to visually set or adjust documents
right from the light table.

Press Shift + right-click on the page to get the page’s contextual
menu. Choose Set Document, browse and select the PDF file.

If a document is already set for the page, the contextual menu also
gives a shortcut to the Page adjustment function of the Document
Manager.

8.2 The Ink Manager
When adding PDF documents to an imposition, whether as an
imported mark or as a source document, inpO2 automatically fills
the ink table with the colors identified in the document.



8 Working With Documents — The Ink Manager • 163

Release: November 20, 2012

The Ink Manager is available from the inpO2 menu, Show/Hide
option or by the Ink Manager tool icon.

The Ink Manager window behaves as a palette and can remain
opened while working on the light table or when using other func-
tions. All changes applied in the Ink Manager window are immedi-
ately reflected in the layout. 

To close the Ink Manager, use the x button in the upper-right corner
of the window, uncheck the item in the Show/Hide menu or toggle
the Ink Manager tool icon.

The LayoutOutline color used to display page information and out-
lines is not editable from the Ink Manager dialogue. The output of
this ink may be prevented by unselecting the objects that use this
color in the Profiles (see section 2.4: “Profiles”).

Mapping colors inpO2’s ink table is divided in two parts: 

• On the left is the list of colors identified in the project. An icon 
identifies the provenance of the colors: either imported image or 
source document.

• On the right are the output options for the color that is selected 
in the left-hand list.
- Choose Output as: to redirect the selected color to another one 

in the list. For instance, if a same CMYK color is identified dif-
ferently within two source documents (Black vs. Process Black), 
Process Black may be redirected to Black to ensure that only one 
black plate is produced at output.

- Choose None to prevent the selected color’s output. 

Limitations Note that you cannot redirect or prevent the output of a process 
color (cyan, magenta, yellow, black).

To ensure an accurate color display in Acrobat, it is recommended to
check Overprint Preview in the Advanced menu of Acrobat.
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9 Output
In a typical workflow, inpO2 layout and imposition files are sent to a
RIP as flats to be used to prepare the plates for the press. 

inpO2 outputs the imposition in either PDF or JDF formats. It is pos-
sible to output the complete imposition, including the source files
placed in the layout, or only a JDF layout, which can later be popu-
lated by another process.

When an imposition is changed into a PDF format, the resulting file
cannot be edited in inpO2 any more. 

9.1 Main Output Dialogue

To output PDF or JDF files, select the inpO2 > Output menu, or click
on the Output icon in the inpO2 Functions toolbar. This will open the
Output window.

• Sheets to Process defines which sheets to output. 
- All: By default, inpO2 will export all sheets in the project.
- Current Sheet: The current sheet can be selected for output.
- Sheets From - To: A given range of sheets can be selected for 

output.
- Sheets in the Press Run: A Press Run can be selected for output.
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• In the Sides to process section, choose to output both sides of 
your sheets or only the front or back. 
- By default, inpO2 will output both sides.

• Choose which Configuration to use for the output.
- The drop-down list contains all preset Configurations. If none 

have been defined yet, the default settings will output a file of 
the whole job in a single PDF document.

- Click on the “...” button to open the Output Configuration win-
dow (see section 9.2: “Configuring Output Properties”). 

• Settings Summary displays a summary of the settings chosen for 
the current Output Configuration.

• The Destination Folder is where the output file(s) will be saved. 
Click the “...” button to choose a folder.

• When the Open produced files in Acrobat box is checked, all PDF 
files created will be opened in Acrobat after the process is 
completed.

• Click Output to output your imposition, or Cancel to close the 
window without outputting.

9.2 Configuring Output 
Properties
If the user’s needs go beyond the default output settings, it is possi-
ble to define as many different output settings as required. This is
done in the Output Configuration window. This window can be
accessed from the main Output window by clicking on the “...” but-
ton located to the right of the Output Settings drop list or by select-
ing the inpO2 > Presets > Output Settings menu.

The Output Configuration window is similar to other Presets windows
and items can be edited the same way (see section 2.5: “Presets”). 

The Output Configuration offers all the settings available for both
PDF and JDF output. 
• Choose which Profile to use for the PDF output.

- The drop-down list contains all saved items.
- Click the Edit button to open the Profiles window. From there 

create a new profile or simply choose which items to output 
(see section 2.4: “Profiles”).

• Use JDF determines if a JDF file is needed. When unchecked, the 
JDF settings are hidden.
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9.2.1 PDF Output Options

This section explains available options for PDF output.

PDF Output Files: This group allows for advanced controls for better
compatibility with RIPs and preflighting systems. 

• Maximum Supported PDF Version: is the version of PDF that will be 
validated against PDF source documents and written in the 
output files. The PDF version that should be selected is the 
highest version supported by the workflow. At output, inpO2 
validates that the selected version is equal or higher than the 
version of the document files. If the selected version is lower, a 
warning will be displayed.

• If Embed marks fonts is selected, the fonts that are used by inpO2 
for text marks (Helvetica, Times-Roman or Courier) will be 
embedded in the output files. If the checkbox is not checked, the 
RIP resident fonts with similar names will be used (see section 
3.2.1: “Text Mark Presets”). 

• Flat Grouping & File Names: This field allows access to the File 
Naming Convention Presets window by clicking on the “...” button 
that appears when this field is selected (see section 9.2.3: 
“Grouping and Naming Files”).

Destination: This group allows for setting up the output delivery
method and destination.

• Delivery: This drop list specifying the method used to deliver 
output files. Three options are available.
- Unspecified: ask at the time of output. If selected, the destina-

tion folder will have to be set in the main Output window.
- In the folder specified below. If selected, the destination folder 

must be identified in the field below.
- Use source document folder. The output files will be delivered in 

the same folder as the source documents. If there are many 
source folders, the path of the first document found in the run 
list will be used.
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• Folder: Click on the Browse button “...” that appears when the 
field is selected to identify the path.

9.2.2 JDF Output Options 

In inpO2, it is possible to output layouts to JDF format, based on the
CIP4 Layout Creation to Imposition ICS (Interoperability Conformance
Specifications).

JDF format can be used for connectivity with JDF-enabled RIPs.
When JDF is selected, inpO2 sends a “job ticket” to the RIP with a
PDF file appended. Many JDF configurations are possible.

To display JDF settings, ensure that the option Use JDF is selected in
the second field. 

This section explains options that are exclusive to JDF output. All
PDF options described in the section above also apply (see section
9.2.1: “PDF Output Options”). 

• JDF Version: This drop list allows the user to select the version of 
JDF format used to exchange data with the RIP. At this point, two 
versions are available 1.2 and 1.3.

• Type of JDF data: This drop list allows the user to choose between 
two methods for sending files to the RIP. The type that is selected 
will enable appropriate settings in the dialogue.
- Page-based layout description: This type must be selected if the 

RIP executes the imposition process (document page place-
ment). The JDF file contains instructions for the handling of the 
document pages to be imposed and the PDF Marks file. 
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- Imposed flats: This type must be selected if the imposition pro-
cess (document page placement) is done within inpO2. The JDF 
file contains instructions for the handling of the completed PDF 
flats. 

• Include cutting parameters: If selected, the JDF file will provide 
cutting information to preset JDF-enabled guillotine controllers. 

Page-based
layout description

inpO2 will create a JDF file containing a layout and run list, plus a
PDF file for marks. Document pages are optional for the creation of
the JDF file. However, if documents are not indexed, Reservation
pages must be placed in the Run List (see section 8.1.1: “About inpO2
Run Lists”). 

The two sub-groups of properties that need to be set up are as fol-
lows:
• Document files: This group offers different options for the 

handling of the source documents.
- Include in MIME package: All files will be included in a MIME 

package and sent to the chosen destination.
- Reference from actual location: The document files remain at 

their current location and the path is written in the JDF for 
access by the RIP.

- Copy to the folder below: The files are copied to any folder on 
the network. 
The folder Path must be defined in the field below.

- Copy to a subfolder named as below: The files are copied to a 
sub-folder of the chosen destination. If this sub-folder does not 
exist, it will be created during output.
The name of the subfolder must be defined in the field below. 
The default name is Documents. 

• Marks Files: This group offers different options for the handling of 
the Marks files that will be created.
- Include in MIME package: All files will be included in a MIME 

package and sent to the chosen destination.
- Save to the folder below: The files are saved to any folder on the 

network. 
The folder Path must be defined in the field below.

- Save to a subfolder named as below: The files are saved to a sub-
folder of the chosen destination. If this sub-folder does not 
exist, it will be created during output.
The name of the subfolder must be defined in the field below. 
The default name is Marks. 

Imposed flats When the Type of JDF data field is Imposed flats, The JDF file pro-
duced is basically a pointer to the PDF imposed flats that need to be
processed. 

Only one sub-group of properties needs to be defined.
• Imposed Flats: This sub-group gives appropriate information on 

how to handle the PDF Imposed Flats files that will be created.
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- Include in MIME package: All files will be included in a MIME 
package and sent to the chosen destination.

- Save to the folder below: The files are saved to any folder on the 
network. 
The folder Path must be defined in the field below.

- Save to a subfolder named as below: The files are saved to a sub-
folder of the chosen destination. If this sub-folder does not 
exist, it will be created during output.
The name of the subfolder must be defined in the field below. 
The default name is Flats. 

9.2.3 Grouping and Naming Files

It is possible to set a naming convention for your files, using a mix
of variables and text. In inpO2, output files are grouped by defining
the file naming convention.

For example, when inserting the Sheet Number and Sheet Side vari-
ables, inpO2 will create a file for the front and a file for the back of
each sheet. When using Sheet Side only, one file will be created for
all the front sides of the sheets, and one for the all the backs.

The general functioning of the File Naming Convention window is the
same as other Presets dialogues (see section : “Tooltips display when
the mouse cursor is positioned over a field for about one second.”). 

The File Naming Convention window is divided into three parts:
Items, Content and Add Variables.
• Items: Many file naming conventions can be defined. The Items 

section lists all defined presets and works like other presets (see 
section 2.5: “Presets”). 

• Contents is where the string made of variables and text will be 
built. Variables from the Variables section may be inserted and/or 
the text entered directly.

• Variables shows the list of available variables. Select one by 
clicking on it and click on the Arrow icon to insert it to the 
Contents section. The variable will be inserted at the position of 
the cursor.
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• Once the naming convention is built, the user may save it by 
clicking Save and Use Naming convention. 

• Click OK to close the File Naming Convention window and return to 
the Output Configuration window.
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10 Glossary
Here is a list of terms specific to inpO2 and/or the world of imposi-
tion and printing. We hope this helps getting familiar with inpO2.

A

Assembly
In inpO2, an assembly is the root node of the Assembly Tree that gathers folded
booklets to create an imposition. An assembly can be a complete job or part of a
job. You may have many assemblies in the same project. For each assembly,
there is a corresponding run list.

Assembly Manager
The Assembly Manager is the name of the inpO2’s dialogue where imposition
jobs are assembled (see section 4.2: “The Assembly Manager dialogue”). 

Assembly Tree
In inpO2, the Assembly Tree is the arborescence window of the Assembly Man-
ager containing parent/child nodes where the assemblies are created (see sec-
tion 4.3: “Working with the Assembly Tree”). 

ATM
Apogee Template Manager or Model. Template structure used when exporting
layouts in a format to be used by the Apogee Prepress software from AGFA
(*.tpl) (see section 2.5.4: “Exchanging Presets”).

B

Barcode
A barcode is an optical machine-readable representation of data, which shows
data about the object to which it attaches (see section 3.3: “Barcode”). 

Binding
Fastening the printed and folded sheets of a publication into a single unit.
There are a number of methods, most of which are variations of saddle-stitching
and adhesive or “perfect” binding.

Blank Page
Placeholder to complete the run list when the imposition layout contains more
pages than the documents to be printed. A blank page may be used for example
to create empty even page at the end of a chapter when the next chapter starts
on an odd page, see sub-section "Inserting a Blank Page" of section 8.1.2:
Project Tree Functions.

Bleed
Page elements that extend beyond any of the four trim edges are said to bleed
off the page. (The bleed across the spine is known as “crossover” or “crossover
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trap.”) This ensures that when the pages are bound and cut, there is no gap
between the edge of the printed element and the edge of the page.

Bleed Mark
Bleed marks are small linear marks drawn at the corner of the pages to indicate
the page bleed boundaries. 

Booklet
A small saddle-stitched brochure or folded section of a publication (signature).
In inpO2’s Assembly Tree, Booklets are child nodes of the Assembly node. Book-
lets are created from templates. They contain page ranges and pages and may
also contain other inserted Booklets. 

C

Collating Mark
Step-marks printed on the spine edge of signatures to facilitate the collating of
the booklets and check their sequence (see section 3.3: “Barcode”). 

Come and Go
Type of assembly consisting in the binding of two copies of a folded publication
at the time before trimming. This is achieved by the printing of double booklets,
each part sharing the same spine and paginated in opposite direction (see sec-
tion 4.4.4: “Come and Go”). 

Creep
The apparent movement of page images on folded signatures away from the
spine caused by the thickness of the folded paper. Creep is of particular concern
with saddle-stitched publications where each successive signature is folded and
placed inside the previously folded signature. To compensate, pages are printed
slightly closer to the spine on successive signatures (see section 4.5: “Creep
Compensation”).

Cut and Stack
Binding type consisting in trimming the pages and stacking the various piles
while keeping the pagination sequence defined.

D

Density Bar
A Density Bar is a layout object inserted in a project gutters or margins allowing
measuring ink exposure and density.

Document Manager
In inpO2, the Document Manager is the dialogue where the documents are
imported and the run lists are created (see section 8.1: “The Document
Manager”).

F

Flat
The front or back of a printed sheet. Also, the unit of imposed pages used to
produce a plate to print one side of a sheet.
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Folding
In inpO2, a folding is the pagination pattern and the page orientation of a page
group. Foldings can be saved in a library and used in all jobs. The most useful
CIP4 JDF folding catalogs are already included in inpO2’s folding library (see
section 2.2.2: “Page Group Folding”).

Folding Numbers
These numbers on the pages show the initial folding pattern before the incre-
mentation of the pagination algorithm. They help to see how the sheet will be
folded after being printed (see section 2.2: “Pagination Tool”). 

G

Gripper
The leading edge of the paper as it passes through the press.

Gutter
The vertical or horizontal space between columns or rows of pages.

I

Imported Mark
A color bar, CCR mark, logo, or any other PDF image file that is embedded in
inpO2 for template creation (see section 3.1: “Imported Mark”).

Imposition
The arrangement of the individual pages of a book into a multi-page layout for
production of a press plate. This layout is set up so that when the sheets are
printed, folded, and trimmed, the pages are in the correct order and the book is
ready for binding.

Imposition Index Number
This number is actually the number of the page in the whole publication. Page
numbers are incremented from sheet to sheet, as opposed to Folding Numbers
(see section 2.2: “Pagination Tool”). 
In the run list, the pages from the PDF files are each associated to an imposition
index number. inpO2 places the document pages in the layout by matching the
imposition index numbers from the run list with those in the layout.

Ink Manager
In inpO2, the Ink Manager is the dialogue where all the colors from pages and
imported marks that used in the project are listed and may be mapped to other
colors (see section 8.1.7: “Shortcut to documents from the light
table”).

J

Job
A job is the work generated by a customer order for a single printed publication.
In inpO2, the term job is not found in the interface. A printed job can be com-
posed of one or many assemblies. On the other hand, the Assembly Tree may
contain many printed jobs. The inpO2 work files are rather called layouts
(*.layt), managed layouts (.mlay) or assembly projects (*.ably). 
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L

Layout
The arrangement of pages in printing sequence on a flat. In inpO2, a layout is
an imposition plan on the light table. A layout file (*.layt) may contain docu-
ments and be output as PDF or JDF. It may also be exported as a template
(*.tmpl) to be used in the Assembly Manager.

Layout Ink
In inpO2, the Layout Ink is the editable color separation used to outline the
imposition plan and all page information. This color can be printed for proofing
or omitted for final imaging (see section 2.4.3: “Customizing Profiles”). 

Layout Manager
The Layout Manager is the name of the inpO2’s dialogue where imposition lay-
outs are created and optimized using predefined equipment and materials (see
section 5.2: “The Layout Manager dialogue”). 

Layout Page
In the layout, the placeholder (trim box) where the source document page will
be placed.

Linear Mark
In inpO2, mark or bar of variable length and width that can be used for different
purposes in the layout (see section 3.7: “Linear Mark”). 

M

Managed Layout
In inpO2, a managed layout is a project created through the Layout Manager. A
managed layout file (*.mlay) contains specific data used by the Layout Manager.
It can be further edited on the light table. It may contain documents and be
output in PDF or JDF format. 

Margin
In inpO2, the margin is the gutter that surrounds the page group. It is used to
create a zone for the placement of marks such as density bars and imported
marks. This zone must be wide enough to allow for the bleed value.

Marks
The various symbols that are placed on the press sheet or the plate for press and
post-press operators. Marks can be attached to sheets, plates, page groups, or
pages.

Multi-web
Using several web presses (double-web, triple-web, etc.) in series or parallel to
print one job. In this case, several press sheets are folded together in one book-
let, which requires special pagination (see section 4.4.5: “Multi-Web”).
Webs can also be partial or cut into sections before the assembly.

N

Naming Convention
Method for the naming of the files that respects a predefined syntax to ease the
communication between workflow components.
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N-Up
Pagination sequence consisting in spreading a maximum of different pages on a
sheet.

O

Object Properties Palette
In inpO2, a floating palette used to edit the parameters and the position of any
type of object that is selected on the light table (see section 2.3: “Object
Properties Palette”). 

Optimization
a In inpO2, automatic layout calculation for job ganging available within the
Layout Manager dialogue. Optimization is based on predefined equipment and
materials, page formats, paper grain, and product quantities. 

b Optimization is also the name of an optional inpO2 module.

P

Page
a One side, usually printed, of a single leaf of a trimmed and bound publica-
tion.
b The text-and-graphics “image unit” acquired from various documents and
files for printing on (a).
c The trim box in the layout into which (b) is placed.

Page Group
A group of printed pages brought together in the proper alignment and order for
trimming and binding by a single folding operation. In inpO2, a page group may
represent a signature, part of a signature, a step and repeat job, or a single
page. 

Page Head
The top of the printed page. In the layout, a T symbol is used to show the orien-
tation of the page. The T represents the top.

Page Mark
Usually trim and bleed marks attached to the page.

Page Range
In the Document Manager, a tree node gathering multiple single-page PDF docu-
ments that were imported at once.
In the Assembly Tree, a child node of the Booklet representing a range of pages.

Pagination
The manual process of adding numbers to the pages on the layout. The manual
pagination can be saved as a Folding. Also, the automatic process of increment-
ing these numbers in the Assembly Manager.

Partial Web
Paper roll that is narrower than the full size web (half-web, quarter-web, etc.).
When paginating partial web in inpO2, the plate size remains the same but the
page group is adapted to fit on the paper width, whether on the gear side or the
operator side of the press (see section 4.4.6: “Partial Web”). 
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Perfect Bound
A method of binding in which the signatures are folded, stacked and trimmed,
and then glue is applied to the spine edges. This produces a flat-spined book
that opens completely to the back of each page.

Perfecting
Method for printing the back of the sheet. The front is printed, then the sheet is
turned from top to bottom on a horizontal flip axis to print the back.

Planning
a In inpO2, the name of the approach that is offered by the Layout Manager
dialogue. Planning is based on predefined press and post-press equipment and
materials.
b Planning is also the brand name of the optional module of inpO2 for the cre-
ation of post-press driven layouts (bound jobs).

Plate
A plate is a metal, polyester, or paper master that when inked, is used to press
an image onto paper. In inpO2, the plate is the extra surface on which the sheet
can be positioned (see section 1.5: “Sheets and Plates”). 

Press Marks
See Marks.

Press Run
In inpO2, a press run contains one or many product parts that are printed
together using the same set of plates. Many press runs are possible in a Managed
Layout. 

Product Part 
In inpO2, a product part is the smallest component of a printed product that
requires its own production method. It can be flat, folded or bound.

Project
In inpO2, a project is created using the Wizard, the Layout Manager or the
Assembly Manager. A project may contain one or many assemblies or product
parts.

R

Reader’s Spread
In a reader’s spread the publication’s pages are displayed as they will be read in
the completed book.

Register Mark
Figures (usually crossed lines and a circle) placed outside the trim page bound-
aries in color separation overlays to provide a common element for proper align-
ment see the  "Note" of section 3.5: Register Mark. 

Reservation
Placeholder to complete the run list when a document page file is missing; see
sub-section "Inserting a Reservation Page" of section  "Project Tree
Functions" . 

Run List
The run list is the list of all the document files to be printed in final pagination
order. 
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S

Saddle Stitch
A method of binding in which each signature is folded and placed inside the
previously folded signature; when all the signatures are folded and inserted,
they are sewn or stapled together through the center or spine fold.

Sections
Subsets of the page group identifying parts of the sheet that will be cut before
folding. In inpO2 WEB, sections are identified on each page by letters A, B, etc.
and can be used in the Assembly Manager for advanced assemblies (see section
4.4.7: “Use of Sections”).

Sheet
A large piece of paper passing through a press for imprinting by a plate or
plates. On a web press a roll of paper is used in place of multiple sheets.

Sheet-fed Press
A press that prints single sheets of paper, rather than a continuous roll or web
of paper. A sheet-fed press prints more slowly than a web press, and is typically
used for shorter runs.

Sheet Template
See Template

Sheetwise
The most common method for printing the back of the sheet. The front is
printed, then the sheet is turned from left to right on a vertical flip axis to print
the back. 

Shingling
Refers to the means of progressively moving the printed content so that all text
is visible at the same position on every page. Bindings such as “saddle-stitched”
require increasing bind margin towards the outside pages, thus needing such
compensation. See also "Creep".

Signature
The term signature is not used in inpO2’s interface. A signature can be made of
different combinations of one or many folded page groups or sheets. The Booklet
node in the Assembly Tree illustrates better the concept of signature. 

Simplex
Type of work printed on a single-side sheet.

Split Web
After being printed on a web press, the web is slit into sections and the ribbons
are superimposed for in-line folding (see section 4.4.7: “Use of Sections”). 

Step and Repeat
Pagination sequence consisting in adding a maximum number of the same page
on a sheet.
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T

Template
In inpO2, a template is a basic sheet file which is used in the Assembly Manager
to create a complete imposition. A template may contain more than one sheet
(multi-sheet template) (see section 4.2.2: “Templates”).

Text Mark
Printable text lines containing a combination of predefined variables and nor-
mal text (see section 3.2: “Text Mark”). 

Trim Mark
Trim marks are small linear marks drawn at the corner of the pages to indicate
the final trim size of the publication. 

W

Web Press
Cylinder printing machine in which the paper is fed from a continuous reel, as
opposed to sheet fed. Also called reel-fed press. 

Wizard
The inpO2 Wizard allows creating easily imposition projects. Step by step
instructions are presented and its result may be output to PDF, or modified on
the light table.

Work Style
A sheet configuration to address different imposition requirements (sheetwise,
work and turn, work and tumble, etc.).

Work and Back
See Sheetwise.

Work and Turn
To print one side of a sheet of paper, then turn it over from left to right and
print the second side using the same gripper and plate but the opposite side
guide.

Work and Tumble
To print one side of a sheet of paper, then turn it over from gripper to back
using the same side guide and plate to print the second side.
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